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ABSTRACT 

This research studied the effect of channel roughness on micro droplet diameter and 

distributions for two commercially available lubricants in internal minimum quantity lubrica-

tion (MQL). The effect of increased channel roughness in the nozzle of a MQL system was 

tested. Chemical etching was studied to control the roughness of external surfaces of tungsten 

carbide tools. Mixtures of oils and air were flown though internal channels with different 

simulated roughness: as fabricated, partially threaded, and fully threaded. Resultant micro-

droplet sizes and counts were collected on a glass grid for evaluation. Droplet density was 

calculated to characterize the dispersion patterns of lubricant exiting the MQL system. The 

results were compared with outcomes of air flow simulations using a computational fluid dy-

namic approach. Nonparametric statistical analysis was conducted to further analyze the re-

sults of the MQL droplet characterization experiment. Chemical etching of tungsten carbide 

was done using a reagent of hydrogen peroxide and nitric acid. Hand agitation and a combi-

nation of hand agitation and ultrasonic pulsation were used to compare the rates of material 

removal. Scanning electron microscopy images were used to further analyze the surface 

structure of substrates before and after etching. For low viscous lubricant, the rough channel 

surface helped to break large droplets in the boundary layer into smaller droplets and reintro-

duce them into the main downstream flow. The opposite trend was found for lubricant with 

high viscosity, as increased lubricant wall adhesion inhibited the breakdown of droplets 

within the channel, leading to the dispersion of larger droplets. In chemical etching experi-

ments, the synergy of hand and ultrasonic agitation successfully roughened a carbide surface 

within twelve minutes. Hand agitation alone was less successful, and resulted in smoother 

surface finishes. Scanning electron microscopy examination showed that the addition of ultra-

sonic pulsation enabled deep etching that removed all grinding marks on a WC-Co cutting 

tool surface.  
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NOMENCLATURE 

ANOVA  Analysis of Variance 

BUE   Built Up Edge  

CFD   Computational Fluid Dynamics 

CL   Coolube 2210Al 

CT   Castrol Hyspray A1536 

EDM  Electrical discharge machining 

FT   Fully Threaded 

HA   Hand agitation 

HA + US  Hand agitation and ultrasonic pulsation 

MQL  Minimum quantity lubrication 

MIP   Male iron pipe 

MOUDI   Micro Orifice Uniform Deposit Impactor 

PT   Partially Threaded 

T1   Trial 1 

T2   Trial 2 

3D   Three Dimensional 

a   Droplet Radius 

A   Area of droplet calculated by ImageJ 

C   Constant for contact angle calculation 

d   Airborne droplet diameter 

K   Line tension 

N   Airborne Droplet Diameter Constant 

P   Projected droplet diameter 

V   Volume of droplet 

θ   Contact angle 

γLG   Surface tension of liquid relative to gas 

γSG   Surface tension of solid relative to gas 
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γSL   Surface tension of solid relative to liquid 
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1. INTRODUCTION* 

Machining operations use lubrication to maintain tool integrity, reduce tool wear rate 

and heat of machining, reduce friction for better chip formation, increase tool life and de-

crease power consumption, and produce smoother workpiece surface finishes [1]. It is very 

difficult to direct coolant to the cutting edge of a drill bit in a deep drilling operation using 

traditional external lubrication techniques. Lack of adequate lubrication leads to large fric-

tional forces that cause accelerated tool wear and less precision in machining operations [1]. 

Traditional methods, such as flood cooling, spray large amounts of lubrication across the cut-

ting surface. Most of the coolant is not needed because it does not reach the tool chip inter-

face. A disadvantage of flood lubrication is the need for a secondary system to capture, filter, 

and dispose lubricant after machining. An advantage of MQL is that it is a much cleaner sys-

tem than flood cooling and there is no need for fluid recycling. 

MQL delivers micro droplets of lubricant directly to the cutting zone using external or 

internal delivery methods. External MQL is typically used in milling, turning, sawing, and 

griding operations. Internal MQL is more common in milling and drilling, and lubricant de-

livery channels output cutting fluid near the tool edge. In drilling operations, internal chan-

nels aim fluid directly to the cutting edge of the drill bit. MQL decreases operating costs, as 

less lubrication is required for machining.  

Previous studies involving MQL have largely focused on the effects that channel ge-

ometry and mist parameters have on tool life and workpiece finish using external or internal 

delivery methods [1-28]. Studies were found for internal MQL that described the resulting 

droplets and droplet distribution due to different shape and size of coolant channels. Limited 

experimental work was performed to show the effect of channel surface roughness on droplet 

size, its distributions and machining operations. A more comprehensive study on the impact 

of channel surface roughness, therefore, was sought.1 

 

 

*Reprinted with permission from “Effect of Channel Roughness on Micro-Droplet Distribution 

in Internal Minimum Quantity Lubrication” Craig M., Raval J., Tai B., Patterson A., and Hung 

W., Dynamics, vol. 2, no. 4, pp. 336–355, by the authors 2022. 
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1.1.  Objective 

This research (i) characterizes the effect of channel surface roughness on MQL drop-

let size and (ii) studies methods of modifying the surface of WC-Co drill channels to improve 

high aspect ratio drilling performance.  

1.2.  Scope 

The MQL experiment compared the droplet size and dispersion with simulated 

smooth, medium roughness, and very rough surfaces in the outlet of the MQL system nozzle. 

The study used Coolube and Castrol lubricants for comparison. Average droplet size was cal-

culated for both lubricant types flowing through each channel. Droplets were captured from a 

grid system used to characterize the effect of radial distance on droplet dispersion. Computer 

simulated flow analysis of experimental results were used for comparison. Methods to mod-

ify the surface of WC-Co drill channels were explored. A chemical etching process was 

tested to control the surface roughness of WC-Co substrates. Two types of agitation were 

tested to compare the resultant surface roughness, and three etching times were used.  
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2. LITERATURE REVIEW* 

2.1.  Minimum Quantity Lubrication 

Efforts to reduce consumption of lubricants have been driven by economic and envi-

ronmental concerns. Lubrication techniques are deployed to remove heat, control tool wear, 

and aid in chip removal during machining operations. At low cutting speeds flood coolant 

achieves all three of these objectives, but as the cutting speed increases coolant cannot reach 

the cutting zone and this method becomes ineffective [1]. MQL has emerged as a way to re-

duce the amount of coolant used and increase lubrication performance at high machining 

speeds. It uses a pressurized mix of air and lubricant sprayed directly onto the cutting zone. 

MQL can be administered externally using nozzles positioned above the workpiece, or inter-

nally by through tool delivery. In machining applications, MQL has become increasingly 

popular as it decreases manufacturing costs, reduces negative environmental impacts, simpli-

fies cleaning processes, and increases tool life [1-2]. Smaller MQL droplets provide better lu-

brication which decreases tool wear and leads to smoother surfaces on the machined work-

piece [3]. 

2.1.1. Single vs. Dual Channel MQL Systems 

There are two main system designs used in internal MQL, single and dual channel 

(Figure 1). In single channel systems, the lubricant and pressurized air are mixed externally 

and routed through the system spindle [2]. External mixing is done using a metering pump or 

pressurized tank [4]. The metering pump method utilizes a positive displacement micro pneu-

matic pump to connect the lubricant flow with an air blast nozzle. Oil volume is controlled by 

the pump speed. The pressurized tank method uses a pressurized lubricant tank and venturi 

nozzle to mix the aerosol solution. The oil quantity delivered is adjusted by the tank pressure. 

In single channel systems, the rate of oil delivery is dependent on air flow rate [4]. In a dual 

channel setup, air and lubricant are routed through the system in separate channels, and the 

two streams are mixed together near the tool point, or system outlet [2]. The rate of oil deliv-

ery is controlled using a positive displacement pump with a built in speed controller, or a 

pressurized oil tank with a metering valve [4].2In dual channel systems, the oil delivery rate is 

 

*Reprinted with permission from “Effect of Channel Roughness on Micro-Droplet Distribution 

in Internal Minimum Quantity Lubrication” Craig M., Raval J., Tai B., Patterson A., and Hung 

W., Dynamics, vol. 2, no. 4, pp. 336–355, by the authors 2022. 
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independent of the air flow rate. Both systems have advantages and disadvantages. Single 

channel setups are much less expensive than dual, and they are popular in sawing operations 

as dimensional tolerances are more relaxed and the surface roughness is not an important 

control metric. The drawbacks of single channel systems include large lubricant droplets due 

to the longer travel of the aerosol mixture, and instability of mist quality due to the effect of 

inertial and centrifugal force when delivered to the tool tip [2]. Dual channel setups offer a 

more robust lubricant delivery. They result in less dispersion of the aerosol mixture and de-

liver finer and more uniform mist than single channel systems. The biggest disadvantage of 

dual channel systems is the added cost when compared to single channel. 

 

Figure 1. Single vs. Dual Channel MQL 

2.1.2. External and Internal MQL 

Race et al. [5] compared external MQL and flood coolant in face milling operations 

using SA516 grade 70 steel plates and vegetable-based oils. The plates were 250 x 250 x 70 

mm in size. A three axis Hartford LG500 vertical mill was used with a 40 mm diameter Coro-

mill 300 face mill paired with R300-1240E-PL grade 4240 carbide inserts coated with Ti(C, 

N)+Al2O3+TiN (Figure. 2). A SKF MQL system was used to deliver mist at 45 mL/hr. This 

research concluded that MQL reduced tool flank wear and surface roughness of the machined 

part. The effect of each coolant type on the machining energy footprint was also studied. 

MQL resulted in a 1.5 kW reduction in peak machine power when compared to flood coolant. 

This showed that MQL was more economic than flood coolant not only because the reduction 

in lubricant used, but a reduction in energy consumption as well.  
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Figure 2. Milling and External MQL Setup 

Hwang et al. [6] turned AISI 1045 with external MQL and flood lubricant methods. A 

Hwacheon Hi-ECO 10 turning center paired with a Vogel Vario UFV 10-001 MQL system 

was used to conduct the experiment. Empirical equations were derived to verify the results of 

the machining operations. The study showed that lower surface roughness was achieved at a 

higher feed rate using MQL as compared to wet lubrication (0.02 mm/rev and 0.01 mm/rev 

feed rates respectively). If cutting force and surface roughness are considered, MQL is more 

advantageous than wet lubrication. Both methods resulted in similar cutting forces, but MQL 

achieved better surface roughness (approximately 30% less rough when compared to wet lu-

brication).  

Li et al. [7] compared dry machining and external MQL using an experimental ap-

proach in grinding operations on a SK3 with HRC18 workpiece. The desktop grinder used 

was equipped with a high speed spindle and three axis machining table. A 600 µm diameter 

#200 grinding tool was chosen for the experiment. Vegetable based oil was run through the 

MQL system at 1.88 mL/hr and 0.5 MPa pressure. The external MQL delivery setup was sim-

ilar to that shown in Figure. 1, using a micro-grinder in place of an end mill. This work 

showed that surface roughness did not change as a function of feed rate or cutting speed using 

MQL. Dry cutting led to an overall rougher surface finish. It was observed that the use of 

MQL increased grinding wheel life 7x versus dry grinding operations. 

Khan et al. [3] used an experimental based approach to study the micro droplet distri-

butions created in through-tool internal MQL. 3D printed ABS plastic adapters were used to 

simulate polished (3.2 µm Ra) vs. rough (16.8 µm Ra) surface finishes. These adapters were 

connected to the outlet nozzle of a Unist Coolubricator system. Coolube 2210EP lubricant 

was used to create micro droplets, and an Arrow B754FM air regulator controlled the inlet air 

pressure. Three tests were conducted using 275 kPa (40 psi), 415 kPa (60 psi), and 550 kPa 

End Mill 

Workpiece 

MQL Nozzle 
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(80 psi) inlet air pressures. Table 1, interpreted from the results of this experiment, showed 

that as the surface roughness increased in the nozzle adapters, the resultant average droplet 

diameter decreased. The air pressure also affected the droplet size. At lower pressures, larger 

droplets were formed.  

Table 1. Resultant Average Droplet Diameters (µm). Adapted From [3] 

Pressure 

(kPa)   

Rough Adapter (16.2 

µm) 

Polished Adapter (3.2 

µm) 

275 
 

9.2 11.42 

415 
 

7.25 9.31 

550   4.69 7.6 

Tasdelen et al. [8] studied internal MQL versus emulsion lubrication in drilling opera-

tions using through tool delivery. The tests were conducted using a Modig MD 7200 drilling 

center at 15000 rpm paired with a Lubri Lean-Vario Super MQL system. MQL led to less 

tool wear and smoother surface finish in the drilled holes. The study also tested continuous 

MQL delivery compared to interrupted flow (23 mL/hr, 15 mL/hr, and 5 mL/hr fluid deliv-

ery) . In continuous, the WC-Co tool inserts showed less wear after drilling operations. The 

best hardened-steel workpiece surface finish result came from 15 mL/hr MQL delivery.  

Maruda et al. [9-10] studied external MQL emulsion mist generation. Maruda’s work 

characterized the effect of air flow, emulsion flow, and nozzle to work-piece distance on the 

size and count of micro-droplets. In this study, water soluble OPORTET RG-2 emulsion, 

commonly used in milling, turning, and threading operations, was tested at a 2% concentra-

tion in water. The results showed that air flow rate and the distance between the nozzle and 

cutting zone had the most significant impact on droplet diameter. An increase in either caused 

the droplet size to decrease and count to increase. Changes in emulsion flow had less impact 

on the droplet distributions.  

2.1.3. Effect of Internal Channel Geometry  

Past studies have been used to characterize the effects that channel shape and size 

have on droplet distributions in internal MQL [11-13]. Raval et al. [11-12] used two experi-

ments to study straight vs. helical channels and circular vs. triangular channels at different 

helical angles. The first experiment utilized a non-coherent white light tomography approach 
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paired with a high speed camera to capture the lubricant stream exiting internal channels of a 

stereolithography additive manufactured drill bit. A Unist Coolubricator dual channel MQL 

system was used to generate microdroplets using Castrol Hyspray Al536 lubricant. Both the 

straight and helical channels were located 2.5 mm from the drill bit axis, and had circular 

cross sections 2 mm in diameter. The channel length was held constant at 70 mm, and the 

helical channels had a 30° helix angle. The results showed that straight channels experienced 

annular flow due to high velocity in the axial direction. This led to higher momentum in the 

axial direction than the radial momentum generated by centrifugal force from drill rotation, 

which caused lubricant wall adhesion [11]. In the helical channels, no annular flow was rec-

orded. These channels generated secondary vortices within that disrupted the annular distri-

bution.  

In Raval’s second experiment [12] the cross section geometry and helical angle of in-

ternal channels was studied using stereolithography 3D printed drill bits. Three different 

channel shapes were tested; circular, triangular, and reversed triangular (triangles rotated 

180°). Each channel was tested using 0°, 30°, and 45° helix angles. The circular channels 

used had 1.6 mm diameters, and the triangular channels were equilateral with 2.15 mm side 

lengths. MQL mist was generated using a Unist Coolubricator with Coolube 2210 lubricant at 

40 mL/hr, a rotary union, and an atomizing chamber. A high speed camera was used to cap-

ture the lubricant flow leaving the drill bit. The channels were centered 2.5 mm from the drill 

bit axis. Because of this small distance, centrifugal force due to drill bit rotation was negligi-

ble. The 0° circular channel showed high mist concentration at the outer edges, and low con-

centration in the center. This created annular flow causing air to travel through the center of 

the channel and lubricant along the outer walls. The 30° and 45° circular helix channels cre-

ated an elliptical shape at the chisel edge. Both resulted in low mist concentration zones away 

from the chisel edge. This created a wider high mist concentration near the chisel edge, and 

narrower concentration zone near the drill origin. The 0° triangle channel showed high mist 

concentrations at the vertices, and low concentration in the center of the channel. In the 30° 

helical triangular channel, the low mist concentration zone shifted downward. In the 45° heli-

cal triangular channel the low concentration zone shifted upward. The reversed triangle chan-

nels mirrored the results of the triangular channels, as the mist distributions shifted 180°. This 

showed that droplet distribution is dependent on the channel orientation. With the changes in 

mist characteristics for each channel tested, this experiment showed that channel shape, helix 

angle, and orientation affect the mist distribution.  
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Kao et al. [13] used an experimental approach with high speed image capturing paired 

with CFD models to characterize the resultant mist patterns in circular and triangular chan-

nels of varying size using internal MQL drill bits. Stereolithography additive manufacturing 

was used to make drill bits with four different channel geometries; Large equilateral triangle 

with side lengths of 2.15 mm, large circle with 1.6 mm diameter, small equilateral triangle 

with 1.35 mm side length, and small circle with 1 mm diameter. The MQL mist was gener-

ated using a Unist Coolubricator at 70 psi air pressure, 45 mL/hr fluid delivery, and a drill bit 

rotational speed of 1000 ± 30 rpm. The results of this study showed that mist structures var-

ied significantly with changing channel geometries. Larger channels showed higher air 

speeds overall, and the circular channels resulted in higher air speeds than triangular. Smaller 

channels also experienced increased droplet coalescence, which caused mist to transition into 

lubricant flow. In the circular channels, flow structure tended to be concentrated toward the 

center of the drill bit. In triangular channels, the flow became concentrated in the vertices. 

This was consistent with the results seen by Raval. CFD models confirmed these experi-

mental results. 

2.1.4. Effect of Oil Type  

Many researchers have worked to classify the effects that oil type has on machinabil-

ity in MQL systems [14-16]. Yildrim et al. [14] used Waspaloy nickel-based super alloy in 

milling operations to test the effects of four different oil types on machinability. These four 

oils included mineral, synthetic, mineral-synthetic, and vegetable based. A delta Seiki CNC-

1050 vertical mill was used with a R300-025A20-10M tool holder and K13A-quality un-

coated cementite carbide tips to conduct milling operations in the experiment. A cutting 

speed of 45 m/min, feed rate of 0.01 mm/rev, and cut depth of 0.5 mm was used. Wear condi-

tions of the cutting tools were examined, and regular flank and notching was observed to de-

termine the effect that each oil type had on machinability. The MQL mist was generated us-

ing a Vario model from SKF set to 8 bar constant pressure. The results of this experiment 

showed that vegetable oil achieved the longest tool life, and tool life decreased with syn-

thetic, mineral, and synthetic-mineral based oils respectively. Vegetable oil performed best 

because its surface tension and viscosity allowed better penetration into the cutting zone. This 

allowed better lubrication between the tool and workpiece. The vegetable based oils formed a 

thin and lasting layer of lubricant in the cutting zone. When compared to the other three oil 
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types, this led to a reduction in cutting force and friction which promoted longer tool life and 

better machinability.  

Tai et al. [15] compared nine cutting fluids (biodegraded esters, renewable acid esters, 

naturally derived synthetic, vegetable based, vegetable based + sulfurized extreme pressure 

(EP), natural fatty oils, and synthetic ester listed in order of increasing viscosity) in terms of 

physical properties, bench tests, and machining tests to determine the effects that various lub-

ricants have on MQL operations. The physical properties studied included density, viscosity, 

flash point, and thermal conductivity. In machining operations, the same amount of heat was 

generated for both MQL and flood lubricant methods, but there was less fluid in MQL to dis-

sipate the heat. Because of this, thermal properties of lubricants determined the ability to re-

move heat. Thermal conductivity was measured at 25°C, 50°C, 75°C, and 90°C using a KO2 

pro thermal property analyzer. It was determined that water based traditional machining lub-

ricants had higher thermal conductivity than common MQL fluids. This indicates that MQL 

fluids have lower heat removal capabilities. When compared to water based lubricants, MQL 

fluids had consistent thermal conductivity across all four temperatures, showing that thermal 

conductivity is independent of temperature. As viscosity increased, thermal conductivity also 

increased in MQL fluids.  

The bench tests conducted by those authors included wettability, lubricity, and ex-

treme pressure properties. Wettability is the contact angle between the lubricant droplets and 

workpiece surface in thermal equilibrium with each other and the gas phase. Lower contact 

angles decrease a droplet’s ability to roll, increasing wettability. The contact angle of each 

lubricant on 6061 aluminum and WC was measured using a sessile droplet test with a DAS 

10 drop measurement system made by KRUSS. The results showed that MQL lubricant had 

lower contact angles and better wettability when compared to water based lubricants. A Mi-

crotap USA tapping torque machine was used to study lubricity of each lubricant using a pre-

drilled aluminum 6061 workpiece tapped with a M8 tool steel tap at 1200 rpm. The results 

showed that water based lubricants had poorer lubricity as they resulted in higher tapping tor-

ques when compared to MQL fluids. Extreme pressure tests evaluate the lubricant perfor-

mance under intense machining conditions. A Falex pin-and-vee-block was used to test each 

lubricant. Better extreme pressure properties were indicated by a higher load needed to shear 

the pin. On average, water based and MQL lubricants performed very similarly. A MOUDI 

from MSP corporation was used to study the microdroplet distribution created for each 



   

10 

 

lubricant. The MOUDI system was run at 30 L/min for 30 minutes. The MQL lubricants re-

sulted in mist concentrations from 8.84 to 11.8 mg/m3 and average droplet diameters from 2.9 

µm to 4.07 µm. The overall trend showed that decreasing viscosity created higher mist con-

centrations and larger average droplet diameters.  

Those authors drilled and reamed spool bores in cast 393 aluminum to characterize 

the effect that each lubricant had on power consumption and hole quality. An Enshu JE50S 

CNC was used with a spindle speed of 12000 rpm. A large majority of the tested MQL fluids 

resulted in higher power consumption than the experimental standard MQL lubricant. A Tay-

lor Hobson Talysurf profilometer was used to measure the surface roughness of the reamed 

holes, and diameters were measured with an air column gauge. The MQL fluids with lower 

viscosities showed finer surface finishes and more accurate hole dimensions. The main corre-

lations were:  

1. Low viscosity resulted in high wettability, high mist concentration, and larger 

droplet diameters. 

2. Large mist diameters correlated with less energy consumption, smoother surface 

finish, and more accurate machined dimensions. 

3. Higher wettability led to better dimensional accuracy.  

The study concluded that low viscosity, large mist droplet diameter, and high wetta-

bility enhanced machinability. 

2.1.5. Effect of MQL on Machining 

Said et al. [17] reviewed how MQL affects turning, milling, drilling, and grinding. 

Comparisons were drawn between dry machining, flood lubricant, and MQL. The results are 

detailed below: 

1. In turning operations, experimental studies showed that MQL improved tool life 

by approximately 25% when compared to dry machining. MQL reduced cutting 

power, improved surface roughness, reduced cutting force, and increased chip for-

mation when compared to flood coolant, while using lesser lubricant quantities [18-

19]. Dhar et al. [20] deployed a plain turning process on 125 mm diameter, 760 mm 

length AISI-4340 steel rod using a 15 hp Lehmann Machine Company lathe. The 
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cutting force, cutting temperature, tool wear, surface roughness, and dimensional ac-

curacy was measured to compare dry, wet, and MQL lubrication techniques. When 

compared to dry and wet machining, MQL showed a decreased temperature at the in-

terface between the cutting tool and workpiece. The lesser quantity of lubrication al-

lowed the MQL aerosol mixture to be elastically drug across the cutting zone by ca-

pillary effect, which created a more effective cooling ability. The high pressure flow 

of MQL allowed for removal of small chips which helped the lubricant reach the tool-

chip contact zone. Using MQL, tool hardness was retained due to lesser abrasive tool 

wear. MQL reduced the rate of growth of tool flank wear because of a reduction in 

flank wear temperature. These effects led to an increased tool life when compared to 

wet and dry machining. The part’s surface roughness was affected by residual feed 

marks left by the tool tip, irregular deformation of the tool cutting edge due to fractur-

ing and wear, machine vibration, and BUE. Because MQL reduced tool wear, surface 

roughness grew more slowly using MQL compared to dry machining. After 45 

minutes of machining, MQL resulted in a surface roughness of 4.25 µm Ra compared 

to 6.25 µm Ra in wet machining (Table. 2). MQL also improved surface finish by re-

duced abrasion, tool chipping, and BUE formation. The maximum principle flank 

wear for MQL inserts was ~225 µm less than that of dry machining. 

Table 2. Surface Roughness and Flank Wear vs. Machining Time. Adapted From 

[20] 

Machining 

Time (mins) 

Surface Roughness Ra (µm) Average Principle Flank Wear (µm) 

MQL Dry Wet MQL Dry Wet 

15 3.25 3.75 4.00 140 150 125 

30 3.50 4.40 4.75 225 280 275 

45 4.25 5.00 6.25 350 475 480 

Chetan et al. [21] characterized the wear behavior of PVD TiN coated carbide turning 

inserts when machining Nimonic 90 and Ti6Al4V. A MQL emulsion mixture (10:1 ratio of 

water and sunflower oil) was used in comparison with dry machining. Figure 3 shows where 

the lubricant was delivered in reference to the tool-chip interface. The results showed that ap-

plying the mixture to Ti6Al4V allowed ample wetting, decreasing the intensity of flank wear 

at high cutting speeds. The lubricant also better penetrated the surface of the Ti6Al4V work-

piece, reducing flank wear when compared to Nimonic 90. 



   

12 

 

 

Figure 3. Emulsion Fluid Delivery 

2. In milling operations, dry machining was used due to the increase in crack propa-

gation in the tool because of temperature fluctuation. An issue with this was seen in 

difficult to machine materials, where the temperature in the cutting zone became very 

high. This led to poor machinability and tool wear, and because of this MQL was in-

troduced into milling operations. MQL was more effective than flood cooling at low 

cutting speeds for milling, as it led to lower cutting force due to a reduction in adhe-

sion and frictional forces (~5 N reduction) [22]. Iskandar et al. [23] studied the effect 

of air and oil flow rate and nozzle distance from the cutting zone on MQL flow char-

acteristics. These effects were then compared to flood coolant in milling operations to 

study the resulting cutting force, temperature, tool wear, and dimensional accuracy. 

Particle image velocimetry and phase doppler anemometry visualization methods 

were used to define MQL flow. Air flow rates of 20, 25, 28, 31 L/min and oil flow 

rates of 10, 17.5, 24 mL/min were tested. The study showed that as air and oil flow 

rate increased, flow velocity increased. As the distance from the nozzle to the cutting 

zone increased the flow velocity decreased, and the droplet size and count increased. 

Optimal MQL spray was obtained by combining the maximum air flow rate (31 

L/min) and minimum oil flow rate (10 mL/min), generating a large number of small 

droplets. In milling operations, various combinations of MQL air and oil flow rates 

showed similar tool temperatures (only 7% variation). The optimal MQL spray gener-

ated temperatures on the high end of the data set. Feed force was the same for MQL 

and flood coolant. Tool wear was 20-30% less using MQL when compared to flood 

coolant (Table. 3). The optimal MQL spray generated the lowest tool wear (17% less 

than other MQL combinations). MQL also held better dimensional accuracy than 

flood coolant, with the optimal spray satisfying the tool requirement of ± 10 µm.  

Workpiece 

Chip 

Cutting Insert 

Emulsion Fluid Droplets 
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Table 3. Air and Oil Flow Rate Effect on Flank Wear and Tool Temperature. 

Adapted From [23] 

Air Flow Rate 

(L/min) 

Oil Flow Rate 

(mL/min) 

Flank Wear (µm) 

at 450 mm Cut-

ting Length 

Tool Temperature 

(°C) at 450 mm 

Cutting Length 

N/A Flood Coolant 30 N/A 

31 24 28 300 

20 24 25 270 

31 10 22 280 

In micromilling, MQL was studied to compare the effect of droplet size and air speed 

on surface roughness and tool wear [3]. High pressure MQL (550 kPa) increased air 

speed, and when paired with a rough lubricant delivery channel (16.8 µm Sa) a Ø5 

µm average droplet size was achieved. Low pressure MQL (275 kPa) decreased air 

speed, and when paired with a smooth lubricant delivery channel resulted in a Ø9 µm 

average droplet size. At a milling distance of 20 mm the high pressure-rough channel 

test resulted in approximately 1.5 µm Sa surface roughness and 10 µm tool wear. At 

the same milling distance the low pressure-smooth channel resulted in approximately 

2.75 µm Sa surface roughness and 25 µm tool wear (Table. 4). 

Table 4. Effect of Air Pressure and Channel Type on Surface Roughness and Tool 

Wear. Adapted From [3] 

Air Pressure 

(kPa) 

Channel Type Surface Roughness Ra 

(µm) at 20 mm Milling 

Distance 

Tool Wear (µm) 

at 20 mm Milling 

Distance 

275 Rough 2.45 30 

275 Smooth 2.75 25 

550 Rough 1.50 10 

550 Smooth 2.15 22 

3. In drilling operations, MQL delivered better machining performance when com-

pared to dry machining. Rahim et al. [24] compared MQL and dry machining using 

drilling operations on the titanium alloy TI-6Al-4V. This study showed that dry ma-

chining resulted in a much shorter tool life when compared to MQL (0.2 mm tool 

wear at cutting lengths of 100 mm and 450 mm respectively) due to chipping, high 

temperatures, and increased frictional force. Drilling experiments on a AA1050 alu-

minum workpiece using a K10 drill bit were conducted by Davim et al. [25] to com-

pare flood cooling and MQL. The results showed that the surface finish, cutting 

power, and cutting force required for MQL and flood coolant were very similar. 
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Surface roughness measurements were approximately 3.5 µm, 2.25 µm, and 2.0 µm 

Ra for dry, flood coolant, and MQL respectively using .15 mm/rev feed rate and 75 

m/min cutting speed (Table. 5). The cutting power and specific cutting force was ap-

proximately 500 W and 2500 MPa across all three methods. In these experiments 

MQL was achieved using fluid deliveries in order of mL/hr compared to L/hr for 

flood coolant. 

Table 5. Lubricant Type and Feed Rate Effect on Surface Roughness. Adapted 

From [24] 

Lubricant Type Feed Rate (mm/rev) Surface Roughness Ra (µm) 

at 75 m/min Cutting Speed 

Dry 
0.15 3.50 

0.25 5.00 

MQL (250 mL/hr) 
0.15 2.25 

0.25 2.30 

Flood Coolant (120 L/hr) 
0.15 2.00 

0.25 2.05 

Patil et al. [26] compared MQL to dry and flood coolant in through tool delivery drill-

ing. This two-level factorial experiment was aimed at studying the effect of air pres-

sure (413, 620 kPa) and MQL oil quantity (40, 60 mL/hr) on machinability. Flood 

coolant was delivered at 340 and 5678 L/hr using pressures of 76 and 83 kPa. A380 

aluminum plates were drilled using ∅8 mm drills, at 250 m/min cutting speed, 9950 

rpm spindle speed, 0.20 mm/flute chip load, and 3980 mm/min federate. Hole over-

size (µm) and cylindricity (µm) was measured to compare the drilling results of each 

lubricant. Oil quantity did not affect drilling quality. Economically, either MQL lubri-

cant delivered in small quantities would be more advantageous than flood coolant. 

The higher viscosity MQL lubricant (28 mm2/s compared to 14.5 mm2/s) provided the 

lowest hole oversize of 5.0 µm. Flood coolant resulted in the best hole shape, having 

the lowest cylindricity of 6.1 µm. This was possibly a result of low heat under flood 

cooling reducing thermal distortion. The cutting flute profiles were studied after drill-

ing for both MQL fluids. The lower viscous lubricant, which formed a smaller contact 

angle on aluminum, provided smaller airborne droplets and better wetting and lubrica-

tion. This decreased BUE formation, which in turn decreased the surface roughness of 

drilled holes. This work showed that in internal MQL drilling, smaller microdroplets 

increased wetting capability, allowing the lubricant to further penetrate the tool-chip 

interface and cool the chip and tool more effectively.  
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2.2. Surface Modification 

Many manufacturing processes can be used to control the surface of a workpiece: 

EDM, grinding, polishing, lapping, and sand blasting. Applying any of these processes to in-

ternal lubricant delivery channels of a drill is a challenge. Many drills incorporate helical 

channels for lubricant delivery (Figure 4). Because of small geometry, the methods listed 

above cannot be applied as it would be very difficult to access the internal surface of the 

channels using traditional contact methods. Liquid flow or slurry based methods can be used 

for internal surface modification.  

 

Figure 4. Dual Helical Lubricant Delivery Channels on a Twist Drill  

An applicable method for roughening the surface of metallic workpieces is chemical 

etching. The process can be accelerated by raising the temperature or adding ultrasonic agita-

tion. Etching is most commonly applied to external surfaces to increase the surface roughness 

and/or improve adhesion properties for coatings.  

Chemical etching of WC-Co has been conducted using a two stage etching process 

[29-32]. The first stage used Murakami Solution (K3[Fe(CN)6]) or similar solutions to break 

down WC. The submersion time for this step varied from 5-80 minutes. The second step in 

this process was etching of the Co binder. This was done using multiple different acids.  

Haubner et al. [29] conducted trials on hard metal inserts (94% WC, 5.5% Co, 0.5% 

(Ta, Nb)C) using a Murakami solution (10g K3[Fe(CN)6], l0g KOH, 100ml H20) pretreatment 

paired with a Caro’s acid etching process (5% H2S04, 35% H202). This study was performed 

to improve adhesion of diamond coatings on metal workpieces by pretreating the surface. Be-

fore etching, the substrates were cleaned using water. Trials were conducted using Murakami 

etching times of 0, 5, and 80 mins with and without a 10 second post-etching process using 

Caro’s acid. SEM images were captured to study the surface finish after each etching trial. 

The author observed that the Murakami solution dissolved WC particles after 5 minutes of 

submersion, leaving the Co binder. Past 5 minutes, very little change was observed in the 
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surface structure. In trials that began with a Murakami solution etch, the 10 second etching 

process with Caro’s acid partially dissolved the Co binder, leaving a textured surface finish. 

Microprobe measurements were used to show that Caro’s acid rapidly removed the Co 

binder. When Murakami etching did not precede the Caro’s acid etch, the process had little 

effect on the substrate. The Co binder was still present in the surface of the workpiece after 

the 10 second Caro’s acid etching.  

Chakravarthy et al. [30] performed a similar experiment to Haubner in using a two-

step Murakami solution and Caro’s acid etching process to study the effect on a WC-Co (8% 

Co) substrate. This study was conducted to increase the surface roughness of WC-Co tools 

such that adhesion of diamond deposition particles could be improved. Coatings were studied 

to improve tools used for machining hypereutectic aluminum-silicone alloys commonly used 

in the automotive industry. The research team used an ultrasonicator to agitate the substrate 

in Murakami solution for 30 minutes, followed by a 15 second Caro’s acid etch. After etch-

ing, the substrates were cleaned with ethanol such that they could be seeded with diamond 

nanoparticles. SEM images showed that the as purchased WC-Co substrates had an average 

grain size of about 1 µm. It was shown that the Murakami solution roughened the substrate 

surface by removing WC particles. Caro’s acid etching then caused oxidation of the Co 

binder to a soluble Co2+ compound. This caused a reduction in the concentration of Co on the 

substrate surface. 

Sha et al. [31] studied the effects of etching on WC-Co (15% Co) using a two-step 

process of Murakami solution combined with a HNO3:HCl (1:1 ratio) etching solvent. This 

study was used to improve adhesion of diamond coatings on the surface of WC-Co sub-

strates. The workpieces used in this study were 9 x 5.5 x 3 mm grounded pieces. The initial 

grinding process yielded a substrate surface roughness of 0.2 µm Ra. The process utilized a 

1-3 minute Murakami reagent etch followed by a 10-40 minute HNO3:HCl etch. After etch-

ing the parts were cleaned in an ultrasonically pulsed acetone bath and weighed to determine 

the weight loss during etching. The overall results of this experiment were an increase in 

weight loss and decrease in hardness as etching time increased. The researcher observed that 

as the etching time in the second step increased the weight loss increased significantly up to 

30 minutes. Longer etching periods resulted in only slight increases in substrate weight loss. 

After the two step etching process the resultant surface roughness was increased to 1.0 µm 

Ra. The Co binder content decreased from the original 15% to a range of 0.84-6.04%. An 
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overall etching depth of 5-10 µm was achieved. The authors concluded that the Murakami so-

lution first removed WC grains, allowing the acid to deplete the Co binder.   

Jung et al. [32] performed chemical etching on WC-Co (10% Co) samples using alter-

natives to the two step etching process previously discussed. This research was aimed at 

providing a better etchant than Murakami solution to study the grain interfaces of carbide 

substrates. When grains in the metal matrix were very small, it was difficult to observe the 

microstructure, thus etching was performed to create distinction. In past studies, Murakami 

solution showed indistinguishable grain boundaries in SEM images. The WC-Co substrate 

samples used in this experiment were created by isostatically pressing a powder mix under 

200 MPa of pressure. The substrates were then sintered at 1375°C for 1 hour under vacuum 

using a graphite furnace. Each sample was then polished to achieve a 1 µm surface finish. 

The first alternative etching process was tested using a reagent of boiling H2O diluted HCl for 

a 12 hour submersion. The researcher discovered that when the WC-Co substrates were 

boiled in HCl, the Co particles were dissolved. The interface between WC and Co became 

visible, but the WC grain boundaries were not revealed. This method was undesirable be-

cause it required a long soak time to break down the Co particles and expose the WC grains. 

The second alternative method involved soaking in an etchant composed of 90% H2O2 and 

10% HNO3 at 60°C for 12 minutes. This method dissolved the Co particles much faster than 

the first. Unlike the boiling HCl, the new etchant was able to dissolve WC particles as well, 

which allowed for the WC-Co interface and WC grain boundaries to become visible.  

2.3. Ultrasonic Cleaning  

Ultrasonic pulsation is commonly used for cleaning applications. In a reagent bath, 

ultrasonic waves help to continuously flush the cleaning solution from the surface of a part, 

allowing fresh solvent to stay in contact with the workpiece. This same phenomenon can be 

applied in etching processes [30] such that uncontaminated etchant solution is constantly in 

contact with the surface of the workpiece. The second aspect of ultrasonic pulsation is the 

formation of cavitation bubbles on the surface of the workpiece. When bubbles grow and be-

come unstable they burst, causing a pressure wave to propagate throughout the reagent and 

remove loosely adhered contaminants.  

Brujan et al. [33] studied the bursting pressure of cavitation bubbles formed by ultra-

sonic pulsation. Shock waves emitted by the collapse of cavitation bubbles on the rigid wall 



   

18 

 

of a workpiece had the largest damage potential. Brujan used a sinusoidal ultrasonic pulser at 

1.08 MHz for 30 cycles paired with a 60 dB radio frequency amplifier to generate ultrasonic 

waves. An aluminum block was used as the solid wall workpiece. During cavitation, when 

bubbles expanded to their maximum volume, they violently collapsed creating a shock wave 

of pressure. This shock wave was captured using an IMACON 200 high speed camera with a 

200 millions/s framing rate at 5 ns exposure time. Images on the fluorescent screen were then 

recorded with a 4800 x 3920 pixel array ICCD camera system and digitized to 12-bit resolu-

tion. The shock wave velocity, captured by high speed imaging, was used to calculate the 

pressure values along the front of the shock wave. At a distance of 68 µm from the bubble 

wall, the maximum shock wave pressure was measured to be 1.3 ± 0.3 GPa. Extrapolation of 

the data showed that pressures on the wall of the workpiece were as high as 7.7 ± 1.6 GPa. 

These results were in line with the work of Pecha and Gompf [34]. WC-Co has a compressive 

strength of 3347-6833 MPa and a tensile strength of 370-530 MPa [35]. These values are at 

least one order of magnitude lower than the minimum bursting pressure of cavitation bubbles. 

2.4. Summary of Literature Review and Research Gap 

Previous MQL research has focused on the effect of channel geometry, lubricant type, 

and aerosol flow parameters on mist characteristics, and machining results using internal and 

external delivery methods. Past studies have shown that in both external and internal MQL 

high air pressure decreases the microdroplet size. Low viscosity lubricants have smaller con-

tact angles, increasing wettability and machining quality. There has been little research into 

how channel roughness affects the droplet distributions and subsequent machining in drilling 

operations.  

Chemical etching of WC-Co substrates has been studied to roughen surfaces for better 

adhesion. Efforts have been made as well to study microstructure and the interface between 

WC grains and the Co binder. The following section presents the experimental work and 

computer simulations on how surface finish of MQL nozzles affect droplet size, and proposes 

a technique to modify nozzle surface texture.  
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3. EXPERIMENTS* 

3.1.  MQL Droplet Characterization  

3.1.1. Equipment 

The MQL system (Figure 5) consisted of the Unist Coolubricator (Michigan, USA) 

(D) with three connecting test tips at the output nozzle (E). The system was connected to a 

compressed air supply through an air regulator (A), air flow meter (B), and pressure gauge 

(C). A paper grid stored under a 236 x 182 mm glass picture frame (F) was used to collect the 

micro droplets distributed by the MQL system. A jack plate (G) was used to adjust the dis-

tance between the test tip and glass plate. 

 

Figure 5. Micro droplet system. A: Air regulator, B: air flow meter, C: pressure 

gauge, D: MQL Unist Coolubricator, E: output nozzle, F: drop collection plate, and G: jack 

plate.3(B) 

 

*Reprinted with permission from “Effect of Channel Roughness on Micro-Droplet Distribution 

in Internal Minimum Quantity Lubrication” Craig M., Raval J., Tai B., Patterson A., and Hung 

W., Dynamics, vol. 2, no. 4, pp. 336–355, by the authors 2022. 
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Figure 6 shows detailed schematics of how the Unist Coolubricator copper nozzle was 

mounted to the test tips. A brass hose splicer was connected to the copper nozzle and 3.175 

mm (1/8-in) x 6.25 mm (1/4-in) diameter Barbed Barb x MIP Adapter Female Fitting using 

Ø6.25 mm vinyl tubing. The tubing was wrapped in Ø9.525 mm (0.375 in) vinyl tubing to 

add rigidity when securing the hose clamps. The smooth, partially threaded, and threaded 

3.175 mm x 6.35 mm diameter Barbed Barb x MIP Adapter Male Fittings were screwed into 

the female fitting. 

Figure 7 shows a polar coordinate layout of the collection grid used to acquire data 

pertaining to the droplet distribution as a function of radial distance. Due to the conical shape 

of exit aerosol mixture from a channel, eight different zones surrounding the nozzle were 

used to capture most of the droplets. The 8 locations were used to collect images at 5 differ-

ent distances from the outlet tip (0 mm, 39.6 mm, 50.8 mm, 61 mm, 93.4 mm). Before each 

test, the outlet tip was centered above location 5, making it the origin point. 

 

(A) 

 

(B) 

Figure 6. Test Tip Assembly and Dimensions 

Threaded Male Fitting 

Female Fitting Brass Hose Splicer Copper Nozzle 

Vinyl Tubing 

Hose Clamp 

2 mm 

∅1.85 mm ∅1.85 mm 3-48 or 2-

56 Thread 

∅7.20 mm ∅4.77 mm ∅6.35 mm ∅6.52 mm 
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Figure 7. Polar Coordinate Representation of Collection Zones. The Origin is at the Center of 

the Tip Projection at Location 5 

3.1.2. Materials 

Three channel finishes were achieved by modifying Barbed MIP adapters. A smooth 

channel was tested using an as drilled fitting. A PT channel was made using a #2-56 tap 

(∅2.18 mm) to create internal threads. The major diameter cut only partial threads in the 

channel. The FT channel was threaded with a #3-48 tap (∅2.51 mm). This tap cut fully into 

the channel, creating deeper threads and a rougher internal surface finish. Past studies showed 

that threading from the entrance to the exit of the tip caused lubricant build up at the exit. Be-

cause of this, for both the PT and FT channels, the threads were not tapped all the way 

through to the tip. Approximately 2 mm of the channel was left untapped to decrease the 

amount of lubricant coalescence at the outlet of the nozzle. Both Coolube 2210Al and Castrol 

Hyspray Al536 were tested. The properties of each lubricant, gathered from manufacturer 

data sheets and the work of Patil et al. [26], are shown in Table 6.  

  

24° 

7 mm 

7 m
m
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Table 6. Tested Lubricants and Properties. Adapted From [26] 

Properties Coolube 2210Al Castrol Hyspray A1536 

Oil Type Fatty Acid and Alcohol Mixture Vegetable 

Kinematic viscosity at 40°C 

(mm2/s) 
14.5 28 

Kinematic viscosity at 100°C 

(SUS) 
Not Available 148 

Flashpoint (°C) 93 194 

Density (kg/L) 0.82-0.92 at 60°C 0.838 at 20°C 

Thermal conductivity at 40°C 

(W/m°K) 
Not Available 0.1593 

Contact angle on glass 6° 22° 

Solubility 
Hydrocarbons, 

alcohols 
Insoluble in water 

The tip to grid distance was optimized at 356 mm to avoid lubricant coalescence on 

the collection grid. This distance was used for every test. 

3.1.3.  Methods 

The fixed and variable parameters used for micro droplet collection are shown in Ta-

ble 7A and 7B respectively. The following procedure was used for micro droplet collection:  

1. The Unist Coolubricator was set to 40 strokes/min lubricant delivery.  

2. A compressed air line was connected to the system and the inlet pressure was set to 

690 kPa (100 psi).  

3. The smooth, PT, or FT tip was connected to the system.  

4. The tip to grid distance was set to 356 mm (14 inches).  

5. A bubble level was used to ensure parallelism of the tip and collection grid.  
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6. The glass plate was cleaned using glass cleaner then acetone. A weight was hung 

from the system outlet tip to position it above location 5 on the collection grid. 

7. The system was turned on and the tip was covered for 30 seconds to allow for lu-

brication flow to start.  

8. The blockade was removed. After 1 second the tip was covered to stop the collec-

tion period.  

9. The grid was transferred to the Olympus STM6 microscope (Japan) for image cap-

turing. One 7 x 7mm2 microscopic image of droplet distribution was captured at the 

center of each zone seen in Figure 4. The images were then processed and the result-

ant droplet diameters were captured using Adobe Photoshop and ImageJ respectively.  

10. Steps 1-9 were repeated for each channel roughness using Coolube and Castrol 

lubricants. 

Table 7. MQL Droplet Collection Parameters 

A. Fixed Parameters 

Parameter 
Tip to Grid 

Distance 

Air Flow 

Rate 

Air Pres-

sure 

Pump 

Frequency 

Collection 

Time 

Lubricant 

Quantity 

Set Point 
356 mm 

(14 in) 
0.566 m3/hr 

690 kPa 

(100psi) 

40 strokes/ 

min 
1 second 60 mL/hr 

B. Variable Parameters 

Parameter   Channel Roughness Lubricant Type 

Set Point   

Smooth, Partially Threaded, 

Fully Threaded 

Coolube vs. 

Castrol 

Nonparametric statistical analysis was conducted to further analyze the results of the 

droplet distributions. The experimental design for this analysis is shown in Table 8. 
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Table 8. MQL Droplet Characterization Experimental Design 

 A: Lubricant Type B: Radial Distance (mm) C: Channel Roughness 

1 Coolube 0 Smooth 

2 Castrol 0 Smooth 

3 Coolube 39.6 Smooth 

4 Castrol 39.6 Smooth 

5 Coolube 50.8 Smooth 

6 Castrol 50.8 Smooth 

7 Coolube 61 Smooth 

8 Castrol 61 Smooth 

9 Coolube 93.4 Smooth 

10 Castrol 93.4 Smooth 

11 Coolube 0 PT 

12 Castrol 0 PT 

13 Coolube 39.6 PT 

14 Castrol 39.6 PT 

15 Coolube 50.8 PT 

16 Castrol 50.8 PT 

17 Coolube 61 PT 

18 Castrol 61 PT 

19 Coolube 93.4 PT 

20 Castrol 93.4 PT 

21 Coolube 0 FT 

22 Castrol 0 FT 

23 Coolube 39.6 FT 

24 Castrol 39.6 FT 

25 Coolube 50.8 FT 

26 Castrol 50.8 FT 

27 Coolube 61 FT 

28 Castrol 61 FT 

29 Coolube 93.4 FT 

30 Castrol 93.4 FT 

3.2. MQL Lubricant Flow Simulations 

Simulations of the MQL flow within each channel were conducted to analyze the ex-

perimental based results. ANSYS Fluent 2020 software was used along with the boundary 

conditions listed in Table 9.  
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Table 9. MQL Simulation Boundary Conditions 

Boundary 

Condition 

Total In-

let Pres-

sure 

(psig) 

Static 

Inlet 

Pressure 

(psig) 

Outlet 

Pres-

sure 

(psig) 

Inlet 

Tempera-

ture (K) 

Outlet 

Tempera-

ture (K) 

Primary 

Phase 

Specification 60 25 0 300 300 Air 

 

3.3. Chemical Etching of WC-CO 

3.3.1. Equipment 

 

Figure 8. Chemical Etching Setup. Where, A: Hot Plate, B: Glass Pan, C: 250 mL Beaker, D: 

Tool Hanger, E: Jack Plate, F: Ultrasonic Pulser, G: Chilled Bath 

Figure 8 shows the system used for chemical etching of the WC-Co samples. A Lab 

Depot Inc. hot plate (A) was used to heat the reagent bath. A series of water baths were used 

to allow for ultrasonic waves to be transmitted through the reagent while keeping the 50 kHz 

frequency ultrasonic pulser (F) within its operating temperature range and out of contact with 

A 

B 

C 

D 

E 

F 

G 
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the etching solution. A large glass pan (B) was used to contain the heated water bath. A 250 

mL beaker (C) was placed in the hot water bath, centered over the hot plate. This beaker con-

tained the etching solution. Nylon fishing line was used to attach a 6.35 mm x 6.35 mm 

dowel rod and binder clip, creating the tool insert hanger (D). The line was spooled around 

the dowel to control the height of the hanger, dictating the depth in which the inserts were 

submerged in the reagent. To isolate the ultrasonic pulser away from the hot plate, a jack 

plate (E) was used such that the large glass pan could be offset to the side of the heated sur-

face. An ice-chilled water bath (G) was used to reduce the temperature of the water surround-

ing the ultrasonic pulser.  

3.3.2. Materials 

The etchant developed by Jung et al. [32] was used in this experiment to characterize 

the effect of etching on surface roughness. This solution was created using a 9:1 ratio of 34% 

hydrogen peroxide (H2O2) and nitric acid (HNO3) respectively, heated to 60°C. For ease of 

mixing, the molar ratio was converted into a mass ratio such that each chemical could be 

weighed for quick measuring purposes. Hydrogen peroxide and nitric acid have molar masses 

of 34.01468g/mol and 68.01284g/mol respectively. The conversion was completed as fol-

lows:  

9 mol H2O2 x 34.01468g/mol = 306.13212g of H2O2 

1 mol HNO3 x 63.01284g/mol = 63.01284g of HNO3 

Since only small amounts of reagent were used for each trial, these values were re-

duced by a factor of 20. The mixture used for each experiment was effectively measured to 

be a ratio of 15.30g H2O2 and 3.15g HNO3. The mass of each solution was measured using an 

AWS LB-1000 compact scale.  

The WC-Co workpieces used in the etching experiment were K20 TPG 433 C2 trian-

gular milling inserts (6% Co) (Pennsylvania, USA). These inserts were chosen because they 

have similar composition to the WC-Co internal MQL drill bits used in industry.  

 

  



   

27 

 

3.3.3. Methods 

1. The fume hood fan and light were turned on.  

2. The jack plate height was set such that the static ultrasonic bath dish was supported 

level between it and the hot plate.  

3. The ultrasonic pulser was placed in the ice bath. The ice bath dish was set in the 

static bath centered above the jack plate. The ice bath was filled such that the ultra-

sonic pulser was fully submerged. 

4. A 250 mL beaker was placed in the static bath centered above the hot plate. The 

static bath was filled until approximately the 50 mL mark on the beaker was sub-

merged.  

5. The 90% H2O2 10% HNO3 solution was mixed by adding 3.15g of HNO3 to 

15.31g H2O2. The mixture was then added to the 250 mL beaker.   

6. The hot plate was turned on high (setting 9) to allow the reagent to heat until it 

reached 55°C. The heat was then lowered to setting 4 such that the reagent could sta-

bilize at 60°C.  

7. The tool insert was cleaned using isopropyl alcohol and dried with paper towel. 

After cleaning, the insert was secured in the tool hanger binder clip.  

8. In trials that utilized the ultrasonic pulser, the run time was set to 900 seconds and 

the device was turned on. Note: The timer had to be reset during the 20 minute trials.  

9. The tool hanger was slowly unspooled and the tool insert was lowered into the 250 

mL beaker until the tip was submerged in the reagent. The tool hanger was gently agi-

tated by hand until the etching run time concluded.   

10. After the tool was removed from the reagent it was rinsed with water. 

11. The used reagent was disposed of in a safe container. The 250 mL beaker was 

rinsed with water and dried using compressed air.  

12. Steps 4-11 were repeated for the remaining trials. The ultrasonic pulser ice bath 

was replenished as needed. 
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13. After the etching experiment the tool inserts were cleaned using a 10 minute iso-

propyl alcohol bath. Images were captured on the Alicona Infinite Focus G4 measure-

ment system (Austria). Ra and Sa roughness measurements were taken on both pre 

and post-etched surfaces.  

14. Before SEM and optical images were captured on the TESCAN Vega3 (Czech Re-

public) and Olympus STM6 microscopes respectively, samples 1 and 3 were cleaned 

using a 30 minute ultrasonically pulsed acetone bath. The samples were allowed to 

dry in a dry box for 2 hours before being transported to the microscope.  

The initial test was conducted using hand agitation (HA) for 12 minutes. The tool in-

sert was viewed under an optical microscope to analyze the extent of etching. It was deter-

mined that the as purchased grinding marks were still visible, and because of this the experi-

ment was run again using a 20 minute etching time. After 20 minutes the grinding marks 

were no longer visible. The 12 and 20 minute tests were then run using a combination of hand 

agitation and ultrasonic pulsation (HA + US). The 12 minute HA + US run etched enough 

material such that the grinding marks were no longer visible. Because of this, a 5 minute 

etching time with HA + US was run to analyze the results. A second trial was then conducted 

for each experiment described above.  

3.4. Metrology 

 

Figure 9. (A) Microscope Captured (B) Adobe Photoshopped (C) ImageJ Processed 

An Olympus STM6 microscope was used to collect images of the micro droplet distri-

bution seen in each test (Figure 9A). Adobe Photoshop v 22.5.1 was used to convert the mi-

croscope images to grayscale to increase the contrast between the droplets and background 

(Figure 9B). This process is detailed in Appendix B1. ImageJ 1.52a was used to adjust the 

image thresholds and capture the projected area of the microdroplets (Figure 9C). This pro-

cess is detailed in Appendix B2. 

A B C 
1 mm 1 mm 1 mm 
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The resultant surface roughness measurements before and after etching were captured 

using an Alicona Infinite Focus G4 measurement system. The system was calibrated using a 

20x objective lens and Mitutoyo standard 178-602. The upper wavelength filter cutoff was set 

to 470 μm. Surface roughness values were taken using both Ra and Sa measurements. 4 total 

measurements were taken on the top (polished side) and bottom of the tool inserts. On both 

sides a measurement was made in the center and at the edge of the etched and non-etched lo-

cations. Because Ra values are line based, an average of 5 measurements was taken at each 

location. Ra measurements were recorded using a 0.5 mm line and Sa measurements were 

recorded using a 0.25 mm x 0.25 mm area.  

A TESCAN Vega3 microscope was used to capture images of the grain structure 

amongst the surface of the polished side of the tool inserts. This allowed for comparison of 

the pre and post-etched surfaces of substrates tested using HA and HA + US methods. Figure 

10 shows the tooling inserts loaded on the table inside of the microscope’s vacuum chamber.    

 

Figure 10. Scanning Electron Microscope Vacuum Chamber 

An Olympus STM6 microscope was used to capture images at 50x magnification such 

that the results of the SEM imaging could be supported. Helicon Focus 8 software was used 

Electron Gun 

Workpiece on  

4-axis Stage 
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to focus stack microscope images of the etched tool inserts. This process is detailed in Ap-

pendix D.  

Throughout the etching experiment a Raytek Raynger ST20 Pro Standard Noncontact 

Thermometer was used to measure the temperature of the reagent bath.  
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4. RESULTS AND DISCUSSION* 

4.1.  MQL Droplet Characterization  

Figure 11 shows resultant droplets for both Coolube and Castrol lubricants using each 

channel roughness. Some droplets were too small for the ImageJ software to capture (< 1.6 

µm projected diameter), and were not used in analysis. Due to lubricant coalescence, a few 

occurrences of combined droplets occurred. To reduce skew in the distributions, large drop-

lets (> 200 µm projected diameter) were excluded from the analysis.   

 

Figure 11. Resultant Microdroplet Images for Coolube and Castrol Lubricant at 

Location 7 (39.6 mm, 219°) and 690 kPa 

The projected droplet areas A were calculated by ImageJ using the image pixels. As-

suming perfect circles of projected droplets, the projected diameter P was calculated using 

equation (1):4 

𝑃 = 2 (
𝐴

𝜋
)

1/2

                                                                   (1) 

 

*Reprinted with permission from “Effect of Channel Roughness on Micro-Droplet Distribution 

in Internal Minimum Quantity Lubrication” Craig M., Raval J., Tai B., Patterson A., and Hung 

W., Dynamics, vol. 2, no. 4, pp. 336–355, by the authors 2022. 

 

Smooth Partially Threaded Fully Threaded 
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Knowing the respective contact angle θ, and projected size P, the droplet volume V 

was calculated from equation (2), where K = 1 if θ < 90° and K = 0 if θ > 90°: 

𝑃3

𝑉
= (

24

𝜋
) [

(1 − 𝐾𝑐𝑜𝑠2𝜃)3/2

2 − 3𝑐𝑜𝑠𝜃 + 𝑐𝑜𝑠3𝜃
]                                            (2) 

Assuming no evaporation during flight, no splashing when impacting the glass plate, 

and no droplet coalescence on the glass plate, an airborne droplet would have the same vol-

ume as that on the plate. Its airborne diameter d was simply: 

𝑑 = (
6𝑉

𝜋
)

1
3

                                                                     (3) 

 Equations 1-3 were combined and simplified to solve for an airborne droplet diameter 

constant, N, by which the projected diameters of each lubricant were multiplied to calculate 

the airborne droplet diameter d. For Coolube and Castrol oil, N was found to be 0.2699 and 

0.4195 respectively.   
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(B) Castrol 

Figure 12. Airborne Droplet Diameter Distribution for Different Lubricants  

(A) Coolube 
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Table 10. Statistical Analysis of Airborne Droplet Diameters. 

 Coolube (14.5 mm2/s viscosity) Castrol (28.0 mm2/s viscosity) 

Channel 

surface 

Mean 

(µm) 

Standard 

Deviation  

(µm) 

Stand-

ard  

Error 

(µm) 

Drop-

let 

count 

Mean 

(µm) 

Standard 

Deviation  

(µm) 

Stand

ard  

Error 

(µm) 

Drop-

let 

count 

Fully 

threaded 

4.93 4.20 0.05 8445 15.15 11.12 0.25 1905 

Partially 

threaded 

6.71 5.90 0.07 6988 13.53 11.64 0.26 2033 

Smooth 7.05 6.33 0.08 6132 10.41 11.75 0.22 2744 

Figure 12 shows the distribution of drop size as a probability density (frequency of 

occurrence), and the numeric results of these distributions are shown in Table 10 to compare 

the effects of channel roughness on droplet quality and quantity. Opposite trends were found 

for lubricants Coolube and Castrol: 

1. The low viscous Coolube lubricant was easily broken into smaller droplets. The 

ability to self-divide into smaller droplets was enhanced by a rougher surface as evi-

denced with the change from smooth to partially threaded and fully threaded chan-

nels.  

2. The high viscous Castrol lubricant showed the opposite trend. Higher viscosity 

forced lubricant droplets to adhere to the channel wall, forming larger droplet sizes. A 

rougher surface would promote this characteristic, i.e., more lubricant adhering to the 

channel wall and less number of airborne droplets. 

3. Standard deviation showed the spread of droplet size amongst the mean. Due to 

large outlying droplets, the standard deviation was high for each trial. Standard error 

was calculated by dividing the standard deviation of the airborne droplet diameter by 

the square root of the droplet count, and normalized the standard deviation for a more 

meaningful representation of uncertainty throughout the experiment. This was used 
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for a better comparison of the droplet size deviation with respect to the large differ-

ence in droplet count between Coolube and Castrol lubricant. The standard error was 

much lower in Coolube lubricant trials, showing that it was more uniformly distrib-

uted in small droplets. Castrol lubricant, with a higher standard error, showed more 

deviance from the average droplet size due to large droplets and coalescence.  

The low viscous Coolube lubricant allowed the desirable and smaller droplet size with 

increasing channel surface roughness. Such results were confirmed with another study where 

airborne droplets were collected through a rough 3D printed ABS channel and through an ac-

etone polished ABS channel [3]. In a subsequent section, the computer simulation of MQL 

mixture through different channels further explains the effect of lubricant viscosity on quality 

of MQL mixture. 

The MQL mixture is characterized by drop size, speed, and its distribution in a flow. 

Let: 

Droplet density (drops / mm2) =
Number of droplets

Collection area (mm2)
                        (4) 

Figure 13 shows the airborne droplet diameter (calculated using equations 1-3) and 

droplet density as a function of radial distance for Coolube and Castrol. Droplet density is de-

fined as the number of droplets per mm2, and was calculated by dividing the droplet count in 

each image by the image area of 49 mm2.  
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(A) 

 

(B) 

Figure 13. Effect of Radial Distance and Surface Roughness on Droplet Quality of Coolube 

(CL) and Castrol (CT). S: Smooth, PT: Partially Threaded, FT: Fully Threaded 

Figure 13A and Figure 13B show negative trends. The combination of these plots 

summarized the dispersion behavior throughout this experiment. Assuming negligible evapo-

ration of airborne droplets and negligible coalescence of these droplets, the dispersion is due 

to cone shaped air flow at the exit. The experimental data showed the following:  

1. Droplet dispersion: High droplet density was found directly below the nozzle since 

compressed air exited within a cone shape and diverged away from the tip. Higher 

central air velocity constrained the droplets near the central axis of the cone and de-

posited most droplets in the central zone #5.  
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2. Airborne drop size: The data showed drop size was larger at the central zone #5 

compared to other zones. A large droplet with heavy mass and inertia would travel 

straight out of the nozzle and have less tendency to deviate from a flight path due to 

minor turbulence. 

3. Effect of Lubricant Type: The Coolube lubricant, with viscosity of 14.5 mm2/s 

compared to 28 mm2/s of Castrol Lubricant (Table 6), would easily break down into 

smaller droplets to form mist with smaller airborne drop size and higher droplet den-

sity. This reasoning also agrees with the relationship of contact angle and surface ten-

sion in the Gibbs equation [37]: 

𝑐𝑜𝑠𝜃 =
𝛾𝑆𝐺−𝛾𝑆𝐿

𝛾𝐿𝐺
+ (

𝐾

𝛾𝐿𝐺
) (

1

𝑎
)                                                      (5)  

Where, 

θ : contact angle 

γSG : surface tension of solid relative to gas 

γSL : surface tension of solid relative to liquid 

γLG: surface tension of liquid relative to gas 

K : line tension 

a : droplet radius 

Table 6 tabulates the smaller contact angle of Coolube lubricant relative to lubricant 

Castrol. Equation (5) suggests that a liquid with smaller contact angle would form a smaller 

droplet, thus, having the smaller radius a. Patil et al. [26] used a high speed video camera and 

confirmed the smaller airborne drop size of Coolube lubricant compared to that from Castrol 

at different air pressure levels. It is important to note that the effect of radial distance is more 

suited toward external MQL, where the aerosol mixture is sprayed from a distance. In this ap-

plication, the best trajectory of droplet flow would be achieved by aiming the nozzle directly 

at the cutting zone, and keeping the axial distance between the tip and workpiece small. In in-

ternal MQL, the outlet of lubricant delivery channels is very close to the tool-chip interface. 

Because of this, the radial distance is close to 0 mm.  
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The experimental results from this study agreed with information from published lit-

erature. The results of the droplet characterization experiment were consistent with the works 

of Patil et al. [26], who also tested both Coolube and Castrol, and concluded that the combi-

nation of low viscous Coolube lubricant and high air pressure resulted in smaller airborne 

droplets. Tai et al. [16] tested esters, naturally derived synthetics, vegetable based lubricants, 

and fatty oils and showed differing results as an opposite trend in viscosity and droplet size 

was observed. The combination of the trends in Figures 13A and 13B is supported by the 

work of Park et al. [38], who studied wetting area as a function of radial distance from the 

collection zone to the MQL nozzle. Wetting area was defined as the total area covered by 

droplets (mm2), and was shown to decrease with increasing radial distance. The results of the 

droplet density and airborne diameter vs. radial distance graphs support this. With an increase 

in radial distance, the droplet density and airborne droplet size decreased, which corre-

sponded to a smaller droplet coverage area.  

4.2. MQL Mixture Flow Simulations 

The flow of oil-air mixture in MQL was simulated in a circular channel. Due to the 

channel symmetry, only a quarter of a channel was shown for each lubricant (Coolube, or 

Castrol), and different channel roughness (smooth, PT, or FT). Figure 14 shows the velocity 

of the aerosol mixture near the wall of an internal MQL channel.  
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(a) Coolube Lubricant and Air Mixture, Flow Above a Smooth Channel, 410 kPa Pressure. 

  

(b) Castrol Lubricant and Air Mixture, Flow Above a Smooth Channel, 410 kPa Pressure.

 

(c) Coolube Lubricant and Air Mixture, Flow Above PT Channel, 410kPa Pressure. 
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(d) Castrol Lubricant and Air Mixture, Flow Above PT Channel, 410kPa Pressure. 

 

(e) Coolube Lubricant and Air Mixture, Flow Above FT Channel, 410kPa Pressure. 
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(f) Castrol Lubricant and Air Mixture, Flow Above FT Channel, 410kPa Pressure. 

Figure 14. Lubricant Flow Velocity Vectors  

The simulation showed the effect of the channel wall roughness on boundary layer 

and near wall flow pattern: 

1. In a smooth channel, the velocity of the air was parallel to the wall. Because of 

this, the droplets stuck to the wall and it was very difficult for the droplets to reenter 

the bulk of the fluid (Figure 14a and Figure 14b). Similar results were seen in straight 

channels tested by Raval et al. [12], as axial air velocity led to lubricant wall adhesion 

and annular flow.  

2. In a partially threaded channel, turbulent flow was seen due to the threaded wall. 

The thread geometry, typically 60°, allowed air to recirculate back and disrupt the 

boundary layer (Figure 14c and Figure 14d). This was supported by the results of heli-

cal channels [12], which generated secondary vortices that disrupted the boundary 

layer of lubricant on the channel wall.  

3. The effect was more significant in the fully threaded channels (Figure 14e and 

14f). The returning air in a threaded portion effectively disrupted the stagnant layer 

and reintroduced oil droplets back to the main air flow above the threaded wall. As 
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the result, there was more pressure drop in the fluid and the velocity of the air was 

lower (approximately 125 m/s) compared to that in a smooth channel (approximately 

250 m/s).  

The results of the MQL lubricant flow simulation complements the experimental re-

sults showing in Figure 11-13. The Coolube lubricant with low viscosity and low surface en-

ergy broke up into smaller droplets when flowing through a partially threaded channel, and 

even finer droplets in fully threaded channel. This is shown by smaller droplets (Figure 13A) 

and increasing droplet density (Figure 13B). The reason, illustrated with the flow simulation 

above, was due to the recirculating air flow that disrupted the boundary layer and reintro-

duced stagnant oil into the downstream flow. The very fine airborne droplets, however, may 

not have been captured in the experimental study due to possible evaporation or 1µm resolu-

tion limitation of the optical microscope.  

The opposite trend, however, was observed for the higher viscosity and higher surface 

tension of Castrol lubricant. The oil droplets were larger (Figure 13A), and adhered to the 

rough surface of the threaded channel. This caused them to not be recirculated into the down-

stream flow by the very low air velocity within a thread. Therefore, the droplets were larger 

and less airborne droplets were collected (Figure 13B). 
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4.3.  Nonparametric Statistical Analysis 

Analysis was conducted to characterize the effect of each input parameter (lubricant 

type, radial distance, channel roughness) on the response (airborne droplet size). The 

experimental design included 30 different combinations of these parameters, shown in Table 

4.  

A normal probability test (Fig. 15) was used to determine if parametric or 

nonparametric analysis would best characterize the data set. Parametric analysis, or ANOVA 

testing, runs on the assumption that the dataset follows a normal distribution. If this 

assumption is incorrect, ANOVA becomes inaccurate and nonparametric analysis must be 

conducted. The residual trendline (blue) did not fit to the normal line, and because of this, the 

assumption of residual normality was not met. This issue could not be corrected by simple 

transforms or outlier removal, therefore the equal variance assumption was unlikely to be met 

and ANOVA could not be used validly. Because of this, a nonparametric Kruskal-Wallis test 

was conducted.  

 

Figure 15. Residuals Compared to Normal Probability Plot 

The Kruskal-Wallis tests determined the statistical significance between each 

individual input parameter and the responsive airborne droplet size. Testing was conducted at 

a 5% significance level. The results are shown in Table 11.  
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Table 11. Kruskal-Wallis Test Results 

 Lubricant Type Radial Distance Channel Roughness 

P-Value < 0.001 < 0.001 < 0.001 

 

The Kruskal-Wallis tests were interpreted as follows: If the P-value returned by the 

test was less than the significance level (0.05), then the parameter was said to be significant. 

This meant that statistically, the tested parameter had an effect on the response. In this 

experiment, the resultant P-values of all three parameters were < 0.001. This showed that 

lubricant type, radial distance, and channel roughness all had an effect on the resultant 

airborne droplet size. These relationships were further investigated using main effects and 

interaction plots (Fig. 16 and 17).  

 

Figure 16. Main Effect of Lubricant Type, Radial Distance, and Channel Roughness on 

Airborne Droplet Size 

In the main effects plot, a steeper slope of a parameter’s trendline symbolized a larger 

effect on the response. From this, lubricant type had the largest effect on airborne droplet 

size, followed by radial distance and channel roughness. This aligned with the results shown 
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in the droplet distributions (Fig. 12) and airborne droplet size vs. radial distance plots (Fig. 

13). Coolube lubricant generated overall smaller droplets, and showed a decreasing trend in 

droplet size with increasing channel roughness. Castrol lubricant showed an opposite trend, 

and distributed larger droplets. The main effect chart showed a negative, close to linear, trend 

in droplet size with increased radial distance, similar to that seen in Figure 13. The nonlinear 

section, also experienced in the work of Park et al. [38], can be explained by the droplet 

dispersion results. Heavy droplets with high inertia traveling straight out of the nozzle could 

have obscured the conical path toward zone 6 (50.8 mm, 270°), causing smaller and less 

droplets in this area. Future testing with the origin set at the center of the collection grid 

(between zones 5-8) can be conducted for further examination. The effect trendline for 

channel roughness was nearly horizontal, showing a comparatively weaker relationship 

between channel roughness and airborne droplet size. This result was further examined by the 

interaction between lubricant type and channel roughness shown in Figure 17.  

 

Figure 17. Interaction Between Input Parameters for MQL Droplet Characterization Tests 

In the interactions plot, two parameters were said to have minimal interaction when 

the trendlines in their overlapping region ran parallel to one another. By this notation, there 
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was little interaction between lubricant type and radial distance, and radial distance and 

channel roughness. Although only moderate, lubricant type and channel roughness showed 

the highest level of interaction. This aligned with the results seen in Figure 12, which showed 

that the lower viscous Coolube lubricant resulted in decreasing airborne droplet size with 

increased channel roughness, while the opposite trend occurred for the more viscous Castrol 

lubricant. Flow simulations showed that this was an effect of increased wall adhesion in 

rougher channels while testing Castrol lubricant, causing less recirculation of small droplets 

into the downstream airflow. The interaction between lubricant type and channel roughness 

also explained the small effect of channel roughness on airborne droplet size shown in Figure 

16. The opposing trends of Coolube and Castrol lubricants for airborne droplet size with 

increased channel roughness offset the effect of one another in the smooth and FT channels. 

This caused the resultant airborne droplet size to show similarly low values for the smooth 

and FT channels, while the PT channel resulted in a slightly larger size. The interaction 

between channel roughness and lubricant type would cause the need for designers to account 

for these factors together at once.  

 The results of the main effects and interactions plots showed that (i) low viscous 

lubricant delivered through rough internal channels decreased the airborne droplet size and 

(ii) airborne droplet size decreased with increased radial distance for low and high viscous 

lubricants. This agrees with the work of Patil et al. [26] who determined that low viscosity 

lubricants would form smaller airborn droplets and Khan at al. [3] who showed that increased 

channel rougness would decrease lubricant droplet diameter.  
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4.4. Chemical Etching 

The surface roughness measurements are shown in Table 12 where T1 and T2 repre-

sent trials 1 and 2 respectively.  

Table 12. Surface Roughness Before and After Etching. Trials 1 and 2, Each With 4 

Random Measurements. 
  

Before 

etching 

After 5-

min etch-

ing 

Before 

etching 

After 12-

min etching 

Before 

etching 

After 20-

min etching 

HA         

Ra 

Average T1, 

T2 (nm) 

N/A N/A 64, 202 67, 462 62, 125 1001, 997 

S. Deviation 

T1, T2 (nm) 

N/A N/A 10, 18 9, 11 13, 6 213, 36 

HA  

Sa 

Average T1, 

T2 (nm) 

N/A N/A 97, 292 129, 636 112, 

309 

1207, 1453 

S. Deviation 

T1, T2 (nm) 

N/A N/A 6, 51 21, 97 5, 39 49, 139 

HA+US   

Ra 

Average T1, 

T2 (nm) 

81, 70 88, 74 72, 56 760, 150 107, 

154 

1436, 1166 

S. Deviation 

T1, T2 (nm) 

32, 9 31, 7 15, 3 158, 19 6, 3 80, 21 

HA+US     

Sa 

Average T1, 

T2 (nm) 

233, 277 263, 293 260, 106 1089, 289 155, 

242 

1447, 1236 

S. Deviation 

T1, T2 (nm) 

97, 35 108, 37 29, 5 115, 40 31, 19 247, 153 
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Figure 18. Change in surface roughness of WC-Co with etching time. 

Figure 18. shows the percent change in Ra and Sa measurements with time. After 12 

minutes of etching the reagent flow caused by ultrasonic pulsation and the occurrence of ul-

trasonic cavitation caused a greater effect on surface roughness when compared to the exclu-

sively hand manipulated method. At the 20 minute mark the two methods showed similar re-

sults in terms of percentage change in Ra and Sa measurements. As the etching time in-

creased, the amount of material that the etching reagent removed reached a maximum, and an 

upper limit of the resultant surface roughness was formed due to dilution of the etchant with 

material that had been removed from the tool insert. The following reasons for this variation 

in experimental results were considered:  

1. Some inserts used were significantly rougher to begin the etching trials when com-

pared to other inserts. Rough pre-etched surfaces could have allowed deeper etchant 

penetration, thus causing more material to be removed. This could have had an effect 

on the etching process and resultant surface roughness.  

2. Hand agitation allowed removal of etching byproduct from the surface of the tool 

inserts by moving the insert within the reagent bath, thus flushing material from its 

surface. In this experiment hand agitation was controlled manually. Inconsistencies in 

the hand agitation could have affected the level of material removal by the etching 

process, thus causing deviations in the resultant surface roughness.  
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3. In the experiment a simple hot plate was used to heat the reagent bath. The temper-

ature was measured using a non-contact thermometer throughout each etching run 

time. Because of this, the operating temperature fell into a range of 60 ± 10°C. This 

temperature gradient could have affected the etching process.  

Figure 19 and Figure 20 show the SEM image results for the 12 minute experiments 

conducted in trial 1. These images are used to compare the surface roughness between HA 

and HA + US samples. Figure 19 shows each sample at 1000x magnification. The images in 

Figure 20 were all captured at 6000x magnification.  

 

Figure 19. 1000x Image of Etched (A) 12 Minute HA and (B) 12 Minute HA + US Inserts 

Figure 19 was captured to show a high level comparison of the surface roughness in 

each experiment. In the HA sample, the grinding marks from the factory polished surface 

were still visible. This showed that the 12 minute HA experiment only removed a small layer 

of material from the insert. In the HA + US sample no grinding marks were visible, and the 

surface appeared very rough. This showed that the addition of ultrasonic pulsation acceler-

ated the material removal rate in the etching process, resulting in a rougher surface.  

  

A B 
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Figure 20. SEM Images for 12 Minute HA and HA + US Trials 
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Figure 20 showed a comparison of the etched, unetched, and transition regions for the 

HA and HA + US 12 minute trial 1 experiments. These images were captured at 6000x mag-

nification. The unetched images showed very similar results for the HA and HA + US sub-

strates. In the image captured for the HA tool, a filter was used to differentiate between the 

WC grains and the Co binder grains. Grinding marks were visible in both images, and the 

grain sizes were very similar. The etched images showed that the addition of ultrasonic pulsa-

tion resulted in a rougher substrate surface. The HA picture showed a much more uniform 

surface height. More polished carbide grains stayed intact on the surface, causing less area for 

the etchant to penetrate and remove material. The transition zone of the HA insert showed re-

gions of large and smooth grains that had not been attacked by the etchant. These were sur-

rounded by rougher areas where etching had begun. Comparing the HA and HA + US images 

drew attention to a negative effect associated with the addition of ultrasonic pulsation. In 

smooth regions of the HA + US transition zone, crack propagation began on the surface of 

the insert. After researching the work of Brujan [33], this was concluded to be a result of ul-

trasonic cavitation. The ultrasonic frequency caused air bubbles to form on the surface of the 

insert. When those bubbles reached their maximum volumes they burst, sending shock waves 

crashing into the surface the insert. The shock waves are known to produce pressure in order 

of 7.7 ± 1.6 GPa [33], which is much larger than the 530 MPa tensile strength of WC-Co. It is 

believed that this pressure thus caused the surface cracking to occur. These surface cracks are 

what caused large chunks of material to break off at once, resulting in rougher surfaces.  

Figure 21 showed optical images captured on the Olympus STM6 microscope at 50x 

magnification for the corresponding locations depicted in Figure 17. The scale bar in the 

lower right corner of each image represents a 50 µm vertical and horizontal line. The etched 

image for the 12 minute HA + US specimen was very rough, which caused issues with focus 

during image capturing. Helicon Focus 8 software was used to stack multiple images in order 

to create a better focused image.  
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Figure 21. Optical Images for 12 Minute HA and HA + US Trials 

The results from the etched and unetched regions support the conclusions drawn from 

the SEM images. The unetched regions were very similar for the HA and HA + US sub-

strates. Grinding marks were apparent in both, and the images showed that each substrate had 

similar starting points. For the HA insert, grinding marks were still visible after etching. 

These grinding marks were fully removed in the HA + US experiment. This supported the 

conclusion that the addition of ultrasonic pulsation accelerated the material removal rate 

50 µm 50 µm 

50 µm 50 µm 

50 µm 50 µm 
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during the etching process. The images captured in the transition zones were not as conclu-

sive as the SEM results. The 50x magnification of the optical images was unable to capture 

the surface cracking seen on the HA + US insert. The grain structures were also unobservable 

at this magnification level.   

Although the external surface of a carbide cutting insert was etched in this study, the 

material removal mechanism should be the same if etching on the inner surface of coolant 

channels of carbide tools. By achieving a rough surface of internal channels, MQL using a 

lubricant with low viscosity can (i) produce finer droplets (ii) generate higher droplet density 

for uniform lubrication, and (iii) use lubricant efficiently since most lubricant will become 

airborne droplets rather than adhering to the tool channels. The results of the MQL droplet 

characterization and chemical etching experiments can be paired to achieve better lubrication 

properties. 

4.5. Sensitivity Analysis 

Table 13 shows the sensitivity analysis from this study and the consequences of the 

known assumptions being incorrect. Two low risk assumptions were made in the MQL drop-

let characterization portion of the experiment.  

1. The main effect of them being false would be a difference in the true airborne 

droplet volume when compared to those found through calculations. Because oil was 

slow to evaporate under the tested conditions, and the experimental design was cali-

brated to decrease coalescence of droplets on the collection grid, these assumptions 

were presumed to be low risk.  

2. The chemical etching of WC-Co experiment resulted in two high risk assumptions. 

The surface roughness achieved by the etching solution was in order of micrometers, 

while the roughness tested in the droplet characterization experiment, formed by the 

threading of the channels, was in order of millimeters. It was presumed that the be-

havior of aerosol flow would be affected similarly in both scales. Another assumption 

was made that similar effects would be seen in terms of surface roughening when ap-

plying the external etching method to internal lubricant delivery channels. These con-

clusions were drawn in order to advance the current progress for the problem at hand.  
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Table 13. Sensitivity Analysis  

Assumption Potential Negative Outcome Sensitivity 

Assuming perfect circles of 

projected droplets, the 

projected diameter P was 

calculated using equation (1) 

Estimated droplet volume 

varies more than calculated. 

Wetting area becomes 

slightly inaccurate.   

Low Risk Assumption 

Assuming no evaporation 

during flight, no splashing 

when impacting the glass 

plate, and no droplet 

coalescence on the glass 

plate, an airborne droplet 

would have the same 

volume as that on the plate.  

Evaporation would cause the 

amount of lubricant deliv-

ered to be less than what 

was administered. Splashing 

and coalescence would lead 

to collected droplets having 

larger volumes than airborne 

droplets.  

Low Risk Assumption 

The effect of increased 

channel roughness would 

behave similarly in the mi-

crometer scale as the results 

formed in the millimeter 

scale.  

This is an approximation to 

simplify the calculations in 

order to make progress on 

the problem being faced. Fu-

ture work will be used to 

further address this assump-

tion 

High Risk Assumption  

The etchant will affect the 

internal channels similarly 

to the external surface. 

Etching will not make a con-

trollably rough surface in in-

ternal channels.  

High Risk Assumption  
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5. CONCLUSIONS* 

Selecting a cutting fluid for machining can be a tedious and expensive process of trial 

and error. Understanding the fundamentals of MQL and physical properties of lubricants al-

lows optimal operation of MQL and achievement of a highly productive environment. Drop-

let distributions were studied using internal MQL delivered through smooth, partially 

threaded, and fully threaded tips. This experiment showed:  

1. The average droplet diameter decreased as channel roughness increased when test-

ing Coolube lubricant. In Castrol lubricant trials, the opposite effect was shown as the 

rougher channels created larger droplets due to lubricant coalescence and channel 

wall adhesion.  

2. For both lubricant types, the average droplet size and count decreased as a function 

of increased radial distance. This showed that the dispersion of lubricant was most 

concentrated directly beneath the outlet tip, and decreased at further collection points.  

3. Coolube lubricant performed more consistently than Castrol and better represented 

the hypothesized relationship. The research team believed that the higher viscosity of 

Castrol lubricant led to lubrication coalescence at the outlet of the tip, a phenomenon 

that was exacerbated by the rougher channels. This caused large droplets to break off 

and land on the collection grid, skewing the droplet distributions. 

Chemical etching processes were used to characterize the effect of a 90% H2O2 10% 

HNO3 etchant on the surface roughness of WC-Co (6% Co) tool inserts as a function of time. 

The following conclusions were drawn from this experiment: 5 

1. The addition of ultrasonic pulsation accelerated the material removal rate and sur-

face roughening in the 12 minute trials. At the 20 minute point similar results were 

seen for the change in surface roughness between experiments that did and did not in-

corporate ultrasonic pulsation. This suggested that there was an upper limit to the sur-

face roughness achievable before refreshing the etchant.  

 

*Reprinted with permission from “Effect of Channel Roughness on Micro-Droplet Distribution 

in Internal Minimum Quantity Lubrication” Craig M., Raval J., Tai B., Patterson A., and Hung 

W., Dynamics, vol. 2, no. 4, pp. 336–355, by the authors 2022. 
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2. Outlying points on the change in roughness versus time plots were thought to be 

caused by differences in the production batches of the tool inserts, irregularities in the 

amount of hand agitation during each experiment, and instability of the operating tem-

perature during each run.  

3. Optical images showed that the tool inserts started with similar surface structures. 

The HA + US experiments led to rougher surfaces in etched regions when compared 

to the HA runs. In transition zones between etched and unetched areas, surface crack-

ing was visible on the HA + US substrates. This was believed to be caused by the 

bursting of ultrasonic cavitation air bubbles.  
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6. FUTURE WORK 

The continuation of these research efforts can be broken down into the following fu-

ture tasks: 

1. Etching experiments will be tested on the internal lubricant delivery channels of 

MQL drills. It is recommended that etchant be pumped through the channels while the 

drill is ultrasonically vibrated directly or via an ultrasonic bath.  

2. Lubricant flow simulations will be conducted by incorporating the resultant sur-

face roughness created in the etching trials from this experiment.  

3. Further trials will be conducted to verify the results of the microdroplet distribu-

tions by incorporating the channel roughness created in the etching trials from this ex-

periment. It is recommended that multiple low and high viscous lubricants are tested 

and statistical analysis is completed to compare the effect of channel roughness on 

airborne droplet size.  

4. The effect of resultant droplets, induced by internal channel surface roughness, 

will be quantified by drilling operations. 
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APPENDIX A. MQL DROPLET CHARACTERIZATION DATA 

Table A1. Lubricant CL Airborne Droplet Data for Smooth Channel 

Location 
Radial Distance 

From Origin (mm) 

Avg Airborne Drop-

let Diameter (µm) 
Stdev (µm) Count 

 
1 61 5.22 4.25 465  

2 93.4 4.38 3.98 384  

3 61 6.04 4.52 714  

4 93.4 4.31 3.89 369  

5 0 9.67 8.39 1832  

6 50.8 5.81 3.92 611  

7 39.6 7.12 6.03 938  

8 39.6 6.54 5.15 821  

 

Table A2. Lubricant CL Airborne Droplet Data for FT Channel 

Location 
Radial Distance 

From Origin (mm) 

Avg Airborne Drop-

let Diameter (µm) 
Stdev (µm) Count 

 
1 61 4.50 2.28 774  

2 93.4 3.75 2.85 316  

3 61 5.37 4.40 599  

4 93.4 3.58 2.83 306  

5 0 7.78 6.32 2314  

6 50.8 4.88 3.80 654  

7 39.6 10.13 8.11 1288  

8 39.6 5.31 4.91 742  

 

Table A3. Lubricant CL Airborne Droplet Data for PT Channel 

Location 
Radial Distance 

From Origin (mm) 

Avg Airborne Drop-

let Diameter (µm) 
Stdev (µm) Count 

 
1 61 4.50 2.28 774  

2 93.4 3.75 2.85 316  

3 61 5.37 4.40 599  

4 93.4 3.58 2.83 306  

5 0 7.78 6.32 2314  

6 50.8 4.88 3.80 654  

7 39.6 10.13 8.11 1288  

8 39.6 5.31 4.91 742  
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Table A4. Lubricant CT Airborne Droplet Data for Smooth Channel 

Location 
Radial Distance 

From Origin (mm) 

Avg Airborne Drop-

let Diameter (µm) 
Stdev (µm) Count 

 
1 61 7.02 7.88 474  

2 93.4 5.73 7.39 159  

3 61 8.09 6.87 184  

4 93.4 4.54 6.31 290  

5 0 16.71 15.24 624  

6 50.8 7.38 8.27 304  

7 39.6 11.49 13.34 394  

8 39.6 14.44 13.82 318  

 

Table A5. Lubricant CT Airborne Droplet Data for FT Channel 

Location 
Radial Distance 

From Origin (mm) 

Avg Airborne Drop-

let Diameter (µm) 
Stdev (µm) Count 

 
1 61 16.27 10.66 225  

2 93.4 11.71 8.89 105  

3 61 11.21 8.54 187  

4 93.4 9.58 7.09 77  

5 0 16.72 12.41 655  

6 50.8 14.70 9.07 168  

7 39.6 15.82 10.84 272  

8 39.6 14.83 10.16 360  

 

Table A6. Lubricant CT Airborne Droplet Data for PT Channel 

Location 
Radial Distance 

From Origin (mm) 

Avg Airborne Drop-

let Diameter (µm) 
Stdev (µm) Count 

 
1 61 12.37 9.04 308  

2 93.4 9.28 7.51 104  

3 61 9.93 8.37 197  

4 93.4 9.27 7.13 83  

5 0 19.73 17.68 549  

6 50.8 12.59 12.09 212  

7 39.6 13.66 11.88 309  

8 39.6 13.03 12.54 283  
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APPENDIX B. MICROSCOPE IMAGE PROCESSING 

Image processing was completed using Adobe Photoshop v 22.5.1 to create grayscale 

images and ImageJ 1.52a to capture the projected droplet diameters. Tables B1 and B2 detail 

the steps necessary to edit images in Adobe Photoshop and ImageJ respectively. These 

processes were modified from the procedure used by Patil [26].  

Table B1. Adobe Photoshop Image Processing 

 

 

 

1. Open Adobe 

Photoshop and 

upload the 

microscope 

picture to be 

edited. File → 

Open 

 

 

 

2. Adjust the 

image size to 

10 cm in width 

and 300 

pixels/inch. 

Image → Image 

Size 

 

Note: The height 

dimension will 

automatically 

adjust.  
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3. Convert the 

image to 

grayscale. 

Image → Mode 

→ Grayscale 

 

Note: If a message 

box displays asking 

to discard color 

information, select 

discard 

 

 

 

4. Adjust the 

brightness and 

contrast to draw 

a sharper 

boundary 

between the 

droplets and 

background. 

Image → 

Adjustments → 

Brightness and 

Contrast 

 

 

 

5. Using the 

Magic Wand 

tool, select the 

background 

area 

surrounding the 

droplets.  

 

Note: The Magic 

Wand tool is 

located on the tool 

bar on the left side 

of the screen.  
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6. Inverse the 

selection such 

that the droplets 

are selected. 

Select → 

Inverse 

 

 

 

7. Fill the droplets 

in black. Edit → 

Fill → Black 
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8. Crop the image 

to eliminate the 

scale bar in the 

bottom right 

corner.  

 

Note: The Crop tool 

is located on the 

tool bar on the left 

side of the screen. 

 

 
 

9. If any droplets 

were not 

selected nor 

filled black, the 

magic wand 

tool can be used 

to select them 

individually. 

Once selected 

repeat step 6. 

Repeat until all 

droplets are 

filled black.  
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10. Auto-adjust the 

brightness and 

contrast 

settings. Image 

→ Auto 

Contrast 

 

 

11. Auto-adjust the 

image levels to 

correct the 

image tonal 

adjustments. 

Image → 

Adjustments →  

Levels → Auto 

 

 

 

12. Equalize the 

image to turn 

light areas white 

and dark areas 

black. Image → 

Adjustments → 

Equalize 

 

Note: Repeat step 9 

if necessary  
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13. Perform tonal 

adjustments 

using the curves 

setting. Image 

→ Adjustments 

→ Curves 

 

Note: Click and 

drag the curve until 

a crisp black and 

white image is 

obtained. Record 

the input and output 

values for batch 

processing 

 

14. Save the image. 

File → Save As 
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Table B2. ImageJ Image Processing 

 

 

 

1. Open the original microscope 

image corresponding to the 

Adobe Photoshop edited image. 

File → Open 

 

 

 

2. Use the line tool to draw a line 

along the 1 mm scale in the 

bottom right corner of the 

image.  
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3. Set the scale. ImageJ calculates 

the length of the line generated 

in step 2 and records it in the 

Distance in pixels box under the 

set scale window. Analyze → 

Set Scale → Known Distance: 

1000 → Unit of length: µm → 

Check the Global selection box 

to hold this scale for batch 

editing  

 

Note: Known distance is set to 1000 

because the Unit of length is set to 

µm and the microscope image scale 

was 1mm = 1000 µm 

 

 

 

4. Using the procedure from step 1 

open the Adobe Photoshop 

edited picture. Convert to 8-bit. 

Image → Type → 8 Bit 
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5. Adjust the threshold such that 

the droplets are uniformly filled 

and have sharp contrast with the 

background. Image → Adjust → 

Threshold → Select Default and 

B&W → Adjust the Scales as 

necessary → Apply 

 

 

 

6. Separate any merged droplets 

using the watershed function. 

Process → Binary → Watershed 
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7. Select the necessary 

measurements for the final 

results. This experiment 

collected measurements for area 

and perimeter using a decimal 

place limit of 3. Analyze → Set 

Measurements → Check the area 

and perimeter selection boxes → 

Decimal places: 3 

 

 

 

8. Calculate the projected droplet 

areas. Analyze → Analyze 

Particles → Check the Display 

results, Clear results, 

Summarize, and Exclude on 

edges selection boxes 
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9. Using the File → Save As 

function on each tab, save the 

results, summary, and images 

generated.  
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APPENDIX C. CHEMICAL ETCHING DATA 

Tables C1-C20 show the raw data collected for the Ra and Sa measurements for each 

tool insert. In these tables K represents the grinded (polished) side of the insert while B 

represents the bottom. E and C are used to describe the edge and center locations of each 

measurement. For example KE means polished side edge.  

 Table C1. Trial 1 12 min HA Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 75.22 46.10 48.70 47.53 

M2 76.45 52.70 57.60 46.91 

M3 77.30 55.19 63.82 51.63 

M4 77.56 64.34 67.11 53.01 

M5 79.44 80.53 87.38 63.00 

Avg 77.19 59.77 64.92 52.42 

Post-Etching 

M1 76.44 80.48 59.31 63.90 

M2 77.58 43.70 42.00 40.50 

M3 78.13 60.08 64.91 47.40 

M4 80.49 61.90 67.43 61.27 

M5 83.51 66.02 110.58 71.71 

Avg 79.23 62.44 68.84 56.96 

Average Percent Change 2.64 2.64 4.46 6.04 

Average Delta Ra (nm) 2.04 2.04 2.67 3.92 

 

 Table C2. Trial 1 20 min HA Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 61.70 55.10 45.30 50.25 

M2 78.93 63.10 45.46 57.71 

M3 85.77 67.36 52.56 44.99 

M4 93.71 69.71 58.03 48.25 

M5 74.70 70.20 59.29 53.30 

Avg 78.96 65.10 52.13 50.90 

Post-Etching 

M1 1320.80 1266.10 950.50 687.20 

M2 932.99 859.49 661.19 612.71 

M3 1289.80 1111.00 833.16 682.24 

M4 1298.70 1215.80 862.48 980.28 

M5 1484.90 959.18 902.87 1111.50 

Avg 1265.44 1082.31 842.04 814.79 

Average Percent Change 1502.61 1502.61 1562.66 1515.32 

Average Delta Ra (nm) 1186.48 1186.48 1017.22 789.91 
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 Table C3. Trial 2 12 min HA Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 231.77 178.92 201.27 206.76 

M2 197.68 178.60 193.97 197.47 

M3 209.92 181.44 208.72 197.25 

M4 231.60 183.54 211.37 179.81 

M5 256.10 189.21 212.80 187.30 

Avg 225.41 182.34 205.63 193.72 

Post-Etching 

M1 389.00 460.73 461.20 428.31 

M2 447.24 452.86 484.99 442.99 

M3 484.27 483.98 373.84 447.56 

M4 501.43 472.43 482.07 472.43 

M5 525.41 469.24 425.89 534.74 

Avg 469.47 467.85 445.60 465.21 

Average Percent Change 108.27 156.58 116.70 140.15 

Average Delta Ra (nm) 244.06 285.51 239.97 271.49 

  

 Table C4. Trial 2 20 min HA Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 100.68 149.75 102.15 116.16 

M2 126.89 121.00 96.79 183.21 

M3 130.02 144.62 171.59 117.91 

M4 179.83 99.47 111.48 93.70 

M5 100.57 139.59 102.31 120.74 

Avg 127.60 130.88 116.86 126.35 

Post-Etching 

M1 1109.70 708.30 857.40 1033.40 

M2 1037.50 906.58 850.61 855.04 

M3 1117.90 936.27 894.55 1053.20 

M4 1131.30 1045.40 1167.40 1157.50 

M5 811.76 1402.60 1005.50 849.09 

Avg 1041.63 999.83 955.09 989.65 

Average Percent Change 716.33 663.90 717.26 683.29 

Average Delta Ra (nm) 914.03 868.95 838.23 863.30 
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 Table C5. Trial 1 5 min HA + US Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 109.30 99.70 49.20 54.20 

M2 105.80 76.92 59.98 55.08 

M3 135.24 79.40 58.81 46.83 

M4 138.35 78.60 46.58 39.37 

M5 138.60 102.55 41.15 43.49 

Avg 125.46 87.43 51.14 47.80 

Post-Etching 

M1 106.98 90.49 72.70 72.80 

M2 105.59 76.65 60.31 53.91 

M3 113.11 83.32 62.65 55.58 

M4 132.65 92.51 66.34 65.24 

M5 194.01 121.41 68.85 74.89 

Avg 130.47 92.87 66.17 64.49 

Average Percent Change 4.00 6.22 29.38 34.92 

Average Delta Ra (nm) 5.01 5.44 15.03 16.69 

 

 Table C6. Trial 1 12 min HA + US Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 109.90 69.60 65.25 52.40 

M2 86.52 77.17 61.31 74.85 

M3 76.19 73.14 61.49 54.93 

M4 93.83 58.49 62.11 69.26 

M5 110.45 69.85 62.85 61.55 

Avg 95.38 69.65 62.60 62.60 

Post-Etching 

M1 950.90 837.50 686.30 549.96 

M2 601.60 795.86 660.49 509.63 

M3 889.73 636.23 699.15 608.73 

M4 1152.20 679.91 648.17 757.95 

M5 1366.60 695.87 625.88 854.98 

Avg 992.21 729.07 664.00 656.25 

Average Percent Change 940.30 946.79 960.68 948.35 

Average Delta Ra (nm) 896.83 659.43 601.40 593.65 
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 Table C7. Trial 1 20 min HA + US Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 139.50 197.50 106.40 115.10 

M2 82.65 89.44 116.21 105.07 

M3 113.11 88.59 110.97 81.34 

M4 84.06 90.64 120.87 109.49 

M5 94.38 94.39 98.51 94.33 

Avg 102.74 112.11 110.59 101.06 

Post-Etching 

M1 1044.30 1384.30 1333.50 1394.00 

M2 1317.90 1277.80 1215.50 1277.80 

M3 1394.90 1383.20 1263.70 1024.50 

M4 1428.10 1449.80 1610.70 1186.10 

M5 1752.50 2092.20 2025.30 1866.60 

Avg 1387.54 1517.46 1489.74 1349.80 

Average Percent Change 1250.55 1253.53 1247.06 1235.59 

Average Delta Ra (nm) 1284.80 1405.35 1379.15 1248.74 

 

 Table C8. Trial 2 5 min HA + US Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 82.00 63.03 62.30 52.42 

M2 48.56 77.54 42.13 61.91 

M3 62.41 87.39 54.23 69.06 

M4 67.41 89.13 58.95 72.36 

M5 86.37 94.90 84.56 81.64 

Avg 69.35 82.40 60.43 67.48 

Post-Etching 

M1 70.20 59.30 47.30 55.17 

M2 54.50 59.60 60.34 50.88 

M3 66.15 65.85 61.66 61.36 

M4 81.35 106.68 62.86 74.27 

M5 81.67 127.24 68.46 107.24 

Avg 70.78 83.73 70.85 69.78 

Average Percent Change 2.05 1.62 17.23 3.42 

Average Delta Ra (nm) 1.42 1.33 10.41 2.31 
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 Table C9. Trial 2 12 min HA + US Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 68.42 52.90 54.06 59.20 

M2 71.84 59.30 51.17 48.36 

M3 58.73 59.57 51.51 49.86 

M4 49.46 62.39 55.21 56.00 

M5 45.45 60.34 47.34 63.06 

Avg 58.78 58.90 51.86 55.30 

Post-Etching 

M1 170.73 169.58 117.15 152.03 

M2 168.40 137.13 140.99 174.78 

M3 149.94 142.35 123.47 167.87 

M4 178.61 144.77 117.56 108.57 

M5 170.68 163.15 114.35 185.39 

Avg 167.67 151.40 122.70 157.73 

Average Percent Change 185.26 157.04 136.62 185.24 

Average Delta Ra (nm) 108.89 92.50 70.85 102.43 

 

 Table C10. Trial 2 20 min HA + US Ra Measurements (nm) 

    KE KC BE BC 

Pre-Etching 

M1 158.74 166.10 156.77 141.16 

M2 149.79 151.84 160.62 158.78 

M3 151.69 157.84 157.80 137.13 

M4 161.90 158.01 146.76 160.60 

M5 157.43 146.02 157.96 152.01 

Avg 155.91 155.96 155.98 149.94 

Post-Etching 

M1 1122.10 1104.10 1492.90 1187.70 

M2 1337.70 1112.10 991.79 1069.50 

M3 1164.90 995.19 1113.20 1232.30 

M4 1018.60 1385.10 996.73 1098.90 

M5 1121.80 1126.10 1272.40 1370.30 

Avg 1153.02 1144.52 1173.40 1191.74 

Average Percent Change 639.55 633.84 652.27 694.83 

Average Delta Ra (nm) 997.11 988.56 1017.42 1041.80 
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 Table C11. Trial 1 12 min HA Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 104.31 89.39 100.38 95.33 

Post-Etching 132.04 99.89 147.35 139.06 

Percent Change 26.59 11.76 46.79 45.87 

Delta Sa (nm) 27.73 10.51 46.97 43.73 

 

 Table C12. Trial 1 20 min HA Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 114.86 112.64 105.19 116.70 

Post-Etching 1203.20 1252.50 1140.20 1231.60 

Percent Change 947.57 1011.98 983.92 955.32 

Delta Sa (nm) 1088.34 1139.86 1035.01 1114.90 

 

 Table C13. Trial 2 12 min HA Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 104.31 89.39 100.38 95.33 

Post-Etching 132.04 99.89 147.35 139.06 

Percent Change 26.59 11.76 46.79 45.87 

Delta Sa (nm) 27.73 10.51 46.97 43.73 

 

 Table C14. Trial 2 20 min HA Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 114.86 112.64 105.19 116.70 

Post-Etching 1203.20 1252.50 1140.20 1231.60 

Percent Change 947.57 1011.98 983.92 955.32 

Delta Sa (nm) 1088.34 1139.86 1035.01 1114.90 

 

 Table C15. Trial 1 5 min HA + US Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 104.31 89.39 100.38 95.33 

Post-Etching 132.04 99.89 147.35 139.06 

Percent Change 26.59 11.76 46.79 45.87 

Delta Sa (nm) 27.73 10.51 46.97 43.73 
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 Table C16. Trial 1 12 min HA + US Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 104.31 89.39 100.38 95.33 

Post-Etching 132.04 99.89 147.35 139.06 

Percent Change 26.59 11.76 46.79 45.87 

Delta Sa (nm) 27.73 10.51 46.97 43.73 

 

 Table C17. Trial 1 20 min HA + US Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 114.86 112.64 105.19 116.70 

Post-Etching 1203.20 1252.50 1140.20 1231.60 

Percent Change 947.57 1011.98 983.92 955.32 

Delta Sa (nm) 1088.34 1139.86 1035.01 1114.90 

 

 Table C18. Trial 2 5 min HA + US Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 302.22 266.36 307.29 231.17 

Post-Etching 311.94 283.67 331.55 245.69 

Percent Change 3.22 6.50 7.90 6.28 

Delta Sa (nm) 9.72 17.32 24.26 14.52 

 
 Table C19. Trial 2 12 min HA + US Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 103.79 100.47 112.23 106.32 

Post-Etching 295.40 231.43 322.74 306.77 

Percent Change 184.60 130.34 187.57 188.54 

Delta Sa (nm) 191.60 130.96 210.51 200.45 

 
 Table C20. Trial 1 20 min HA + US Sa Measurements (nm) 

  K edge  K Center B Edge B Center 

Pre-Etching 265.82 218.85 245.13 240.05 

Post-Etching 1318.10 1008.10 1327.30 1289.40 

Percent Change 395.87 360.63 441.48 437.14 

Delta Sa (nm) 1052.28 789.25 1082.17 1049.35 

 

 

 

  



   

83 

 

APPENDIX D. IMAGE FOCUS STACKING 

Helicon Focus 8 software was used to stack microscope images to layer different 

levels of focus in order to create a clearer image. Figure D1 shows an image captured on the 

Olympus STM6 microscope (A) before and (B) after focus stacking. The process of using 

Helicon Focus 8 is detailed in Table D1.  

  

Figure D1. Microscope Images (A) Before and (B) After Focus Stacking 

 

Table D1. Helicon Focus 8 Focus Stacking Process 

 

 

 

1. Upload the microscope images 

to be stacked. File → Open Im-

ages 

  

A B 
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2. Choose Render Method B 

(depth map). 

 

 

 

3. Adjust the Radius and 

Smoothing settings as neces-

sary to achieve better focus. 

Use the Render Preview But-

ton to see real time adjust-

ments.  

 

 

 

4. Click the Render button to fi-

nalize the stacked image. 

Save the image. File → Save 

As 

 

 



   

85 

 

APPENDIX E. PUBLICATION 

Craig M., Raval J., Tai B., Patterson A., and Hung W., “Effect of channel roughness 

on micro-droplet distribution in internal minimum quantity lubrication,” Dynamics, vol. 2, 

no. 4, pp. 336–355, 2022. 

 

 

 


